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Notes for the reader

Introduction

This manual helps you to use the Océ TC4. The manual contains a description of the
product and guidelines to use and operate the Océ TC4.

Definition

Attention-Getters

Parts of this manual require your special attention. These parts can provide the following:
■ Additional general information, for example, information that is useful when you

perform a task.
■ Information to prevent personal injuries or property damage.

Warning, Caution and Note

The words Warning, Caution and Note draw your attention to important information.

Overview of the attention-getters#

IndicatesIconWord

Ignoring this warning could cause serious injury or
even death.
The Warning indication has several icons that warn
against various hazards. The icons are shown below.

Warning

General hazardWarning

Hot surfaceWarning

Electric shockWarning

Moving partsWarning

Laser beamWarning
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IndicatesIconWord

Ignoring this warning could cause injury or damage to
property.

Caution

Indicates additional important information.Note

The use of heat-resistant gloves is mandatory when you
carry out these actions.

Safety information

Before using this Océ product, make sure that you read and understand the safety infor-
mation which is part of the user documentation. You can download the safety information
via http://global.oce.com/support/ or, if applicable, find it on the user documentation
CD/DVD that is delivered together with the machine or obtain the safety information
from your local Océ representative. To avoid potential hazards, maintenance is strictly
preserved to properly qualified and trained service technicians.
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Available documentation

Introduction

This manual is part of a complete documentation set. The following table shows a complete
overview of the available documentation.

Available documentation
Available documentation#

MediumDocumentationProduct

■ On http://glob-
al.oce.com/support/
Available as a PDF file
in multiple languages.

■ On CD-ROM
Available as a html doc-
ument and as a PDF file
in multiple languages.

User manual - Operating
information

The Océ TC4

■ On http://glob-
al.oce.com/support/
Available as a PDF file
in multiple languages.

User manual - Safety infor-
mation

CD-ROM, as a PDF file in
English only.

Océ TDS-TCS connectiv-
ity manual.

The Océ TC4 Power Log-
ic®  controller

Embedded in the applica-
tion, as an on-line help file
in 20 languages.

Integrated Océ TC4 Pow-
er Logic® controller appli-
cation on-line help

CD-ROM, as a PDF file in
multiple languages.

Océ Account Center User
Manual

Océ Account Center

Embedded in the applica-
tion, as an on-line help file
in multiple languages.

Océ Account Logic on-
line help.

Embedded in the applica-
tion, as an on-line help file
in multiple languages.

Océ Account Console on-
line help.

Embedded in the applica-
tion, as an on-line help file
in multiple languages.

Océ License Logic on-line
help

Océ License Logic
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MediumDocumentationProduct

Embedded in the applica-
tion, as an on-line help file
in multiple languages.

Power Logic® controller
Remote on-line help

Power Logic® controller
Remote

CD-ROM, as a PDF file in
multiple languages.

Océ Repro Desk User
Manual

Océ Repro Desk

Embedded in the applica-
tion as on-line help file in
multiple languages.

Océ Repro Desk on-line
help

Note:
Visit Océ on the internet at http://global.oce.com/support/ for the latest information.
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How to use this manual

Introduction

You can access a topic quickly with the following methods.
■ Refer to the alphabetical index at the end of the manual.
■ Refer to the table of contents at the beginning of this manual.

Before you turn to the complete table of contents, you can also use the following table
to find a topic quickly.

This manual contains the following chapters.

#

TopicsSectionChapters

contains a general introduction to the Océ
TC4 and the concept, including a general de-
scription of the main features.

Introduction1

■ introduction
■ basic and extended scan-to-file jobs
■ scan job management on the Océ TC4

Power Logic® controller application
■ scan destination management on the Océ

TC4 Power Logic® controller application

Use scanner2

■ introduction
■ Install and start the application
■ Use the application

Power Logic® con-
troller Remote

3

■ introduction
■ concepts of Scan jobs, Scanner templates,

Preferences and Configuration

Océ TC4 Power Log-
ic® controller applica-
tion

4

■ Overview of Océ Publisher Copy
■ Copy settings related to the scanner
■ Do a basic copy job ('Direct copy mode'

enabled)
■ Do an extended copy job ('Direct copy

mode' disabled)

The Océ Publisher
Copy option

5
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TopicsSectionChapters

■ introduction
■ perform tasks in the Océ License Logic

application

Océ License Logic6

■ Océ Account Logic
■ Océ Account Console

Océ Account Center7

maintain the scannerMaintain the Océ
TC4

8

■ overview of the system
■ overview of the graphical operator panels
■ system specifications

Overview and tablesAppendix A

Reader's comment sheet
Addresses of local Océ organizations

MiscellaneousAppendix B

indicates where you can find the information
in the manual with the use of key words.

IndexIndex
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The product concept and complete workflow

Definition

A complete Océ solution includes several different hardware and software products to
manage your complete document workflow. The complete document workflow includes
several different jobs and documents. The following illustration gives an overview of a
complete Océ solution and the document workflow.

Illustration

A B

[10] Overview of the system set-up and control.

Different documents

The complete workflow includes the following different documents.

#

DocumentNr.

Original1

2 File

Different products

The complete Océ solution is a combination of the following elements.
■ Scanner (A)
■ Controller (B)
■ Document management software.

Different jobs

The arrows in the illustration show the different possible jobs. The complete document
workflow of the Océ solution includes the following different jobs.
■ Scan-to-file job.

A scan-to-file job starts with an original (1) and ends with a file (2).
■ Set-up and control the complete workflow.
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Do which job where

Use the following products to do the following jobs.
■ Scan-to-file jobs on the scanner operator panel
■ Set up and control the complete workflow on the controller.
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The Océ TC4 key concepts

Green key principle

The Océ TC4 is a very user-friendly scanner. The scanner is very easy to operate. The
scanner templates offer you extended ease of use because you can use them to store pre-
ferred combinations of settings.

Scanner templates

The scanner offers you a number of customizable templates for the job settings of a scan
job. The scanner templates allow you to store your preferred job settings. To start a job
you simply select a template on the scanner operator panel and press the green start key.
Templates can be managed in the Océ TC4 Power Logic® controller application.

Océ Scan Logic®

The Océ TC4 offers a scan-to-file functionality. Documents are scanned and then stored
digitally. Ten customized scan destinations are supported. Scan jobs and scan destinations
can be managed in the Océ TC4 Power Logic® controller application.

Network connectivity

The Océ TC4 supports a number of popular network protocols. This means that it can
be used in multiple networking environments such as TCP/IP® Pserver (IPX/SPX). You
can configure the system in the network via the Océ TC4 Power Logic® controller appli-
cation.
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User interaction

Introduction

The user can communicate with the Océ TC4 from local locations and remote locations.

Operator panels

The Océ TC4 offers the following user interfaces.
A scanner operator panel for the scanner allows you to define the settings for scan jobs
but also allows you to set scanner settings.

Integrated Océ TC4 Power Logic® controller application

The Océ TC4 Power Logic® controller application supports a centralized workflow.
Only one application with a transparent and intuitive layout where you can perform
many tasks based on user role defined access. Separate work spaces give you a full overview
and full control on scan job management, but also allows you to manage your scanner
templates, system preferences and network connectivity settings. You can also monitor
the status of your system in this application.

Power Logic controller Remote enables you to access the integrated Océ TC4 Power
Logic® controller application from any networked workstation.

Chapter 1 - Introduction 19
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The Océ TC4 users

Introduction

The Océ TC4 will be used by various users within your company or department. Depend-
ing on the tasks that you need to perform on the Océ TC4 you may need certain access
rights to the Océ TC4 and the Océ TC4 Power Logic® controller. The access rights are
appointed by your company. Please contact the person responsible for the scanner to find
out what rights and user role you need to work with the Océ TC4. With the appointment
of the user roles and the dedicated workspaces you can fully customize the scanner to fit
with your workflow.
On the Océ TC4 the following user roles can be identified.

Overview of user rights per workspace in the Océ TC4 Power Logic® controller

The table below indicates if the users have read rights or only view rights in the 4 main
workspaces.

■ X: indicates that the user has full rights in this workspace
■ 0: indicates that the user is only allowed to view the information in the workspace
■ 1: indicates that the user can switch scanner templates from the template library to the

scanner operator panel.
■ 2: indicates that the user is allowed to lock or unlock scan destinations.

#

'Configura-
tion'

'Prefer-
ences'

Scanner
'Templates'

'Scan jobs'Workspace —>

User role

000X'Anonymous'

0001XRepro operator

0XXX2Key operator

X000System administrator

'Anonymous' user

The 'Anonymous' user is a common user who uses the Océ TC4 for scan jobs. The
common or walk-up user has no permission to change the system settings.
In the integrated Power Logic® controller application, the anonymous user can delete his
or her own scan-to-file jobs in the 'Scan jobs' workspace.
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Note:
You do not have to logon to the Océ TC4 Power Logic®  controller application when
you are an 'Anonymous' user.

Repro operator

The repro operator is responsible for the daily use of the Océ TC4 in a central repro de-
partment. This person makes scans on the scanner.
In the integrated Power Logic® controller application, the repro operator has no permission
in the 'Preferences' and 'Configuration' workspaces, limited permission in the 'Templates'
workspace and full permission in the 'Scan jobs' workspaces.

Key operator

The key operator is responsible for the ongoing management of the scanner and the
availability of the scanner for all users. In a large organization he or she will be responsible
for the smooth production of documents and scanned files from external departments.
The key operator will also have to ensure that the staff of the internal department are able
to perform their tasks swiftly and efficiently.
In the integrated Power Logic® controller application, the key operator has full permission
in all workspaces ( 'Scan jobs', 'Templates', 'Preferences') except the 'Configuration'
workspace, which is the responsibility of the system administrator.

System administrator

The system administrator is responsible for the installation and configuration of the Océ
TC4 in its environment. This person defines the security settings and manages licenses.
In the integrated Power Logic® controller application, the system administrator has exclu-
sive permission in the 'Configuration' workspace.

Océ Service

Dedicated user mode for service purposes.
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Get to know the Océ TC4

The Océ TC4

The configuration of the Océ TC4

The Océ TC4 is a high quality and fast wide format color scanner for scanning engineering
documents. The Océ TC4 is available as a scanner only configuration. The Océ TC4
offers scan-to-file functionality. The Océ TC4 can be adapted to the fit in just the way
you want it.
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The Océ TC4 components

Introduction

The Océ TC4 is available as a scanner which can scan-to-file
The Océ TC4 consists of the following components.

#

ComponentNumber

Scanner1

Océ TC4 Power Logic® controller2

The Océ TC4 scanner

[11] scanner

Use the Océ TC4 scanner to make scan-to-file jobs, in color, grayscales or black and
white.

The Océ TC4 Power Logic® controller

The Océ TC4 is equipped with a Océ TC4 Power Logic® controller which helps you to
make optimum use of your scanner.
On the Océ Power Logic® controller an integrated application runs which allows you to
control your entire workflow.

User role defined access allows you to log on to the following workspaces.
■ 'Scan jobs'. In this workspace you can manage your scan-to-file jobs and scan job

destinations on the controller and on the network.
■ Scanner 'Templates'. In this workspace you customize and maintain the scan templates

that are visible on the scanner operator panel of the scanner.
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■ 'Preferences'. In this workspace you have a transparent overview of all the system de-
faults of the scanner and controller.

■ 'Configuration'. In this workspace you manage all settings related to network connec-
tivity, security.

■ The system control bar is always visible in the application and provides you with status
information about the scanner and controller. It monitors the set memory to display
the available storage space on the controller.

Optional software

You can order the following optional features for the Océ TC4 Power Logic® controller.
■ Account Logging.

Account Logging is for accounting purposes, the Océ TC4 Power Logic® controller
is able to keep track of all your jobs. For each job the job information is stored.

■ Océ Publisher Copy.
This option allows you to send a scanned document directly to the Océ ColorWave
600 printer.
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Turn on and off the Océ TC4

Introduction

You can turn on and off the Océ TC4 scanner. The Océ TC4 Power Logic® controller
is switched on and off separately from the scanner. You do not have to use a specific order
in which you turn on and off the Océ TC4 and scanner.

Power On / off
#

ActionPart

Use the On / Off switch at the front underneath the original feed
table on the scanner to turn on and off the scanner.

Scanner

Use the power key at the front of the controller.
Use the On / off key.
When the controlller is on:
Press the key only once and wait 30-60 seconds. The green LED of
the key turns off to indicate that the controller is turned off. Keep
the key pressed for 4 seconds to immediately turn off the controller.
When the controller is off:
Press the key only once to start up the controller. The green LED
is turned on when you press the key.
You can also shut down the controller in the Océ TC4 Power Logic®

controller application. Access the System menu in the top toolbar
to do so.

Océ TC4
Power Logic®

controller
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This chapter describes how to use the scanner.

Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the job settings
in two ways.
■ Use the left softkeys and the scroll wheel.

You can use this method if you prefer a general step by step method.
■ Use the scroll wheel and scroll-wheel key only.

You can use this method if you prefer a fast method.

Note that the scanner operator panel also uses icons to explain a setting. The following
illustration shows the scanner operator panel. For more information about the keys on
the ‘Scanner operator panel’ on page 179
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Illustration

1 2 3 4 5 6 7 8 9 0 

[12] The operator panel of the Océ TC4 scanner

Define job settings with the left soft keys and the scroll wheel

1. Select a job template with one of the left softkeys.
The top 5 settings appear.

2. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll wheel.

3. Select a setting with the left softkey.
There are several types of settings. The behavior of the scanner operator panel and the
definition of a setting depends on the type of setting you selected. You can select one of
the following types of settings.
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■ A setting that contains two values only, like 'On' or ' Off'.
When you select this setting while the setting was not in focus, the setting becomes
in focus. When you select this setting while the setting was already in focus, the setting
stays in focus and there are no changes.
Change the value of the setting with the left softkey. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Define the required value with the scroll wheel. The value and icon changes.

■ A setting that contains a list of settings, like 'Original type'.
Define the required value with the scroll wheel. The value and icon changes.
Select the next setting of the list of settings with the left softkey.

Note:
You can enter a numeric value with the numeric keys. To enter a negative numeric value,
scroll to a negative value first and than enter the value with the numeric keys.

4. Select 'Close' with the lower-right softkey.
5. Repeat from step 4 to define the next setting.

Note:
Use the 'Defaults' option at the lower-left key to set all settings of the job template to
default.

Define job settings with the scroll wheel and scroll-wheel key only

1. Focus on a job template with the scroll wheel.
A small diamond in front of a template indicates the focus of the scroll wheel.

2. Select a job template with the scroll-wheel key.
The top 5 settings appear.

3. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll wheel.

4. Select the setting with the scroll-wheel key.
There are several types of settings. The behavior of the scanner operator panel and the
definition of a setting depends on the type of setting you selected. You can select one of
the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

Change the value of the setting with the scroll-wheel key to change the value of the
setting. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.
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■ A setting that contains a list of settings, like 'Original type'.
Focus on a setting with the scroll wheel. The bold text of a value indicates the focus
of the scroll wheel. The icon changes.
Open the setting with the scroll-wheel key. The list of values appears.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

Note:
You can enter a numeric value with the numeric keys. To enter a negative numeric value,
scroll to a negative value first and than enter the value with the numeric keys.

5. Select 'Close' with the lower-scroll-wheel key.
6. Repeat from step 4 to define the next setting.

Note:
Use the 'Defaults' option at the lower-left key to set all settings of the job template to
default.
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Basic scan-to-file jobs on the scanner

Introduction to scan-to-file jobs

Introduction

A basic scan-to-file job takes two steps. Feed the original and press the start key. Every
other type of scan-to-file job, where you change the scan-to-file settings, is called an ex-
tended scan-to-file job. An extended scan-to-file job takes one additional step. Define the
scan-to-file job settings on the scanner operator panel. The scanner operator panel shows
five scan-to-file job templates. The scan-to-file job templates provide access to the different
settings per scan-to-file job template. When you select a scan-to-file job template, the
scanner operator panel shows the top 5 settings of the selected scan-to-file job template.
The top 5 settings are the most often used settings. You can define the top 5 settings and
their values for each scan-to-file job template with the Océ TC4 Power Logic® controller
application. You can use the scroll wheel to see the other settings. After you start a scan-
to-file job, you can manage your jobs from the 'Scan jobs' workspace in the Océ TC4
Power Logic® controller application.

Illustration

[13] The scan-to-file job templates

Steps in a basic scan-to-file job

1. Feed the original.
2. Press the green start key.

Result

You get a digital file of your original.
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Steps in an extended scan-to-file job without fine tuned job templates

1. Feed the original.
2. Define the scan-to-file job settings at the scanner operator panel.

■ Open a template.
■ Select the first setting and define the value.
■ Select the second setting and define the value.
■ ....
■ Select the last setting and define the value.

3. Press the green start key.

Result

The second step takes several additional actions.

Steps in an extended scan-to-file job with fine tuned job templates

1. Feed the original.
2. Define the job settings.

Select the required template at the scanner operator panel and change the pre-defined
settings only if necessary.

3. Press the green start key.

Result

You get a tuned digital file of your original.
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Do a basic scan-to-file job

Introduction

This section describes a general workflow for a basic scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the de-
fault value for that setting in the Océ TC4 Power Logic® controller application.
After you press the start key, the scanner operator panel always shows the job number
and status of the job. A scan-to-file job appears in the selected destination of the 'Scan
jobs' workspace.

How to do a basic scan-to-file job on the Océ TC4

1. Place the original face down and right aligned.
The scanner takes the original.

[14] Place the original face down and right aligned.

2. Press the green start key.

Result

The scanner scans the original and the sends the scanned file to the default scan-to-file
destination.
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Do an extended scan-to-file job

Introduction

This section describes a general workflow for an extended scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the de-
fault value for that setting in the Océ TC4 Power Logic® controller application.
After you press the start key, the scanner operator panel always shows the job number
and status of the job. A scan-to-file job appears in the selected destination of the 'Scan
jobs' workspace.

How to do an extended scan-to-file job on the Océ TC4

1. Place the original face down and right aligned.
The scanner takes the original.

[15] Place the original face down and right aligned

2. Select a template.
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3. Define the job settings.

[16] The top 5 settings of a scan job template

‘Available settings for scan-to-file jobs’ on page 38
■ Scroll to a setting.
■ Select a setting with the left softkey.
■ Scroll to the required value.
■ Select the next setting with the left softkey.
■ Scroll to the required value.
■ Select 'Close' to close the setting.
■ Repeat the selection of settings from bullet 3 if you need to define more settings.

4. Press the green 'Start' key.

Result

The scanner scans the original and sends the scanned file to the defined scan-to-file des-
tination.
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Stop a scan-to-file job

Introduction

You can stop a scan-to-file job with the red stop key at the scanner operator panel.

How to stop a scan-to-file job

1. Press the red stop key.

Result

When you press the red stop key while the scanner scans, the scan process stops. The
scanner rewinds the original and the scan-to-file job is cancelled.
When you press the red stop key while the scanner rewinds, the rewind process continues.
The scan-to-file job is cancelled.
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Extended scan-to-file jobs

Available settings for scan-to-file jobs

The scan-to-file settings
#

DescriptionSetting

Use this setting to define the default destination for scan-
to-file jobs on the controller. You can define a maximum
of 10 remote destinations and one of these destinations
is the default destination.

'Destination'

Depending on the color mode and file type you select
the values for the compression mode and organization
will change. For some File types, the Compression and
Organization settings cannot be set in all situations.‘'File
type'’ on page 40
Available file types:
■ PDF
■ TIFF
■ JPEG
■ CALS

'File type'

Use this setting to define the resolution of the scanned
images. The higher the resolution you select, the finer
the image quality but the larger the file size. ‘'Resolution'’
on page 42

'Resolution'

Use this setting to define the type of original for your
scan-to-file jobs. The defined type influences the quality
of the output.‘'Original type' and background compensa-
tion’ on page 43

'Original type'

Use this setting to define the width of the original that
the scanner scans.‘'Original width'’ on page 44

'Original width'

Use this setting to define blank areas on the sides of the
scanned image. ‘'Remove strip'’ on page 45

'Remove strip'
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DescriptionSetting

Use this setting to create a mirrored image of an original.
Mirroring occurs in the transport direction. (The image
is mirrored along the vertical axis.)

'Mirror'

Use this setting to define the exposure of the original.
Negative values mean less exposure and darker scanned
output. Positive values mean more exposure and grayer
scanned output.

Note:
This setting can only be set if the color mode
you select is gray or black and white.

'Lighter/darker'
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'File type'

Depending on the color mode and file type you select the values for the compression
mode and organization will change. For some File types, the Compression and Organiza-
tion settings cannot be set in all situations.

Color mode: Grayscale
#

OrganizationCompressionFile typeColor mode

■ 'Raw'
■ 'Tiled'
■ 'Striped'

■ 'None'
■ 'Packbits'
■

'TIFF''Grayscale'

Not available■ 'None'
■ 'Flate'
■

'PDF'

Quality
■ Maximum
■ High
■ Medium
■ Minimum

■ JPEG

Quality
■ Maximum
■ High
■ Medium
■ Minimum

JPEG
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Color mode: Black and White
#

OrganizationCompressionFile typeColor mode

■ 'Raw'
■ 'Tiled'
■ 'Striped'

■ 'None'
■ 'Group 3'
■ 'Group 4'
■ 'Packbits'

'TIFF''Black&white'

Not available■ 'None'
■ 'Flate'
■ 'Group 4'

'PDF'

Not availableNot available'CALS'

Color mode: Color
#

OrganizationCompressionFile typeColor mode

■ 'Raw'
■ 'Tiled'
■ 'Striped'

■ 'None'
■ 'Packbits'
■

'TIFF''Color'

Not available■ 'None'
■

■ 'Flate'

'PDF'

Quality
■ Maximum
■ High
■ Medium
■ Minimum

■ JPEG

Quality
■ Maximum
■ High
■ Medium
■ Minimum

Not availableJPEG
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'Resolution'

Use this setting to define the resolution of the scanned images. The higher the resolution
you select, the finer the image quality.
Select the required scan resolution with the scroll wheel.

#

Value in dots per inchSetting

■ '72 dpi'
■ '100 dpi'
■ '150 dpi'
■ '200 dpi'
■ '300 dpi'
■ '400 dpi'
■ '600 dpi'

'Resolution'

Note:
A higher resolution increases the file size.
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'Original type' and background compensation

Use the 'Original type' setting to define the type of original for scan-to-file jobs. The
defined type influences the quality of the output.
Use the 'Backgnd comp' setting to define the background compensation for your original.
Select the type of original and the background compensation with the scroll wheel.

#

ValueColor modeSetting

■ 'Artwork' for paper
■ 'Lines&Text'
■ 'Photo'
■ 'Map' for transparencies

'Color''Original type'

■ 'Lines&Text' for paper
■ 'Grays&Lines'
■ 'Dark original'
■ 'Blueprint'
■ 'Transparent' for transparencies
■ 'Photo'

'Black&white'

■ 'Lines&Text' for paper
■ 'Grays&Lines'
■ 'Dark original'
■ 'Blueprint'
■ 'Transparent' for transparencies
■ 'Photo'

'Grayscale'

When the background on the original has pollu-
tion, use this setting to improve the quality of the
background.
The compensation depends on the type of the
originals. If enabled, the background compensa-
tion for 'Photo' or 'Grays&Lines' originals is a
standard value.

'Backgnd comp'

Value
■ Auto
■ On
■ Off
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'Original width'

Use this setting to define the width of the original that the scanner scans.

Select one of the following.

#

ResultIconSetting

The scan width is automatically deter-
mined based on the actual width of the
original.

'Auto'

Use this setting to a 'Standard' width of
the original.
The standard widths that you can select
depend on the media series that you select-
ed in the Océ Settings Editor.

'Standard'

Custom-selected width. Use this setting
if the 'Auto' setting or the 'Standard' set-
ting does not give the required result.

'Custom'
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'Remove strip'

Use the 4 settings below to define the blank areas around the image.

Remove strips#

ResultIconSetting

Use this setting to remove a strip at the
top of the image. This action decreases
the image length.

Note:
The top side of the image is the
side that you first feed into the
scanner.

'Remove strip' -
'Leading'

Use this setting to remove a strip at the
bottom of the image. This action decreas-
es the image length.

'Remove strip' -
'Trailing'

Use this setting to remove a strip from
the left side of the image/original viewed
from the face-up direction. This action
decreases the image width.

'Remove strip' -
'Left'

Use this setting to remove a strip from
the right side of the image/original viewed
from the face-up direction. This action
decreases the image width.

'Remove strip' -
'Right'

Chapter 2 - Use the Océ TC4 45

'Remove strip'



Scan jobs on the Océ TC4 Power Logic®

controller application

Scan jobs management

'Scan jobs' workspace

The 'Scan jobs' workspace in the Power Logic® controller application allows you to
configure your scan jobs workflow.
The 'Scan jobs' workspace is divided in three areas that manage the complete scan jobs
workflow.

Areas in the Scan jobs workspace#

DescriptionScan jobs
workspace

Define and manage the local scan destinations.Destinations
on the con-
troller

Define and manage the remote scan destinations.Remote desti-
nations

View scanned documents or view or edit the properties of a scanned
document.

Scan job view
area

Note:
Not all options are available to all users. You must log on as a key operator to perform
all tasks in the 'Scan jobs' workspace.
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[32] Scan jobs workspace

Scan destinations on the controller

In this area of the workspace you find the default destination of the scan jobs. By default,
all the scan jobs are stored on the controller. The default scan job destination cannot be
deleted.

Use the toolbar at the top of the 'Scan jobs' workspace to create, edit and delete the local
scan job destinations on the controller.

The Scan destination area also gives access to the Unsent scan jobs folder. These jobs
must go to a remote destination but cannot be delivered. The jobs are temporarily stored
in the Unsent scans folder on the controller.

Remote destinations

You can create scan job destinations at a remote location instead of at a local destination
on the controller. The remote scan destinations area displays the remote destinations that
you create. The remote destination is a directory on a workstation that is accessible through
the network.

Use the toolbar at the top of the 'Scan jobs' workspace to create, edit and delete the remote
scan job destinations.
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When you select a remote scan job destination the jobs that are stored at the selected
destination are displayed in the right hand side of the workspace, the 'Scan jobs' view
area.

Scan jobs view area

The 'Scan jobs' view area displays all the scan jobs that are stored at the selected scan
destination. The 'Scan jobs' view area can give access to the scan jobs at the local and re-
mote destinations. You can select a file from the list and view the file properties. Some
properties, for example the scan job name can be edited.

Use the toolbar at the top of the 'Scan jobs' workspace to delete, view, edit or send the
selected scan job(s).

Note:
Only a scan job that is stored at a local destination on the controller can be opened with
the view application Océ View Station LT®. Océ View Station LT® is only accessible
from the controller. Power Logic controller Remote does not support this functionality.
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Manage scan destinations in the 'Scan jobs' workspace

Introduction

A scan destination is a place where you send your scanned file to for storage. You can
create, delete and lock scan destinations. You can also define automatic file naming to
ensure your files get the desired names.

A scan destination can also be a file server or a PC of an end user. It is better to select re-
mote destinations instead of the local ones. The local destinations are temporary and
cannot contain a lot of scanned files.

Before you begin

All users have access to the 'Scan jobs' workspace. Make sure you log in as key operator
to the Océ TC4 Power Logic® controller application to have all rights.
A key operator can determine whether a scan destination can be modified by another
user. This is done by locking and unlocking a destination.

Illustration

Create a local destination

1. Click the 'Scan jobs' icon in the vertical icon toolbar.
2. Select the 'On controller' area in the 'Scan jobs' workspace.
3. Open the ‘File’ menu and select 'New' or click the 'New' button in the toolbar. A sec-

ondary window appears in which you can define the properties of the new local destination.
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4. Enter a logical name for the destination in the 'Name' text box.
This logical name also appears on the scanner operator panel.

5. Select 'On controller' from the ‘Type’ drop-down list box.
6. Enter a path of the target folder in the ‘Path’ text box. You can also click the 'Browse...'

button to select the path.
7. Click Ok to accept the destination properties.

Create a network destination with SMB

1. Creating a shared folder on a workstation. For example c:\Scan
2. In the 'Scan jobs' area open the ‘File’ menu and select 'New' or click the 'New' button

in the toolbar. The properties window appears.
3. Select SMB from the ‘Type’ drop-down list box.
4. Enter the system name of the workstation where you created the shared folder.

Note:
Make sure that you enable the setting 'NetBIOS over TCP/IP' in the Power Logic con-
troller application to resolve the system name

Note:
Find the system name of the workstation on the control panel of the workstation (Control
panel - Network - Identification - System name)

5. Enter the system name of the remote location and click 'Find' to identify the system lo-
cation easily.

6. Enter the path name. This is the name of the shared folder on your workstation. For
Windows NT®, Windows® 2000 and XP, use the DOS name of the shared folder. For
Windows 95/98® use the folder name. This is case sensitive.

7. Enter a path of the target folder in the ‘Path’ text box. You can also click the 'Browse...'
button to select the path.

8. If you have set a username and a password for the shared folder on the workstation, then
enter the username and the password in the required fields.

9. Set the required file naming properties
10. Click Ok.

The Power Logic® controller application connects to the new SMB destination. The
'Scan jobs' view area then shows the contents of the new SMB destination.

Create a web destination with FTP

1. Create a home directory and a subdirectory on a workstation. For example c:Ftp/Scan

Chapter 2 - Use the Océ TC450

Manage scan destinations in the 'Scan jobs' workspace



2. Enable FTP on the workstation
3. In the 'Scan jobs' area open the ‘File’ menu and select 'New' or click the 'New' button

in the toolbar. The properties window appears.
4. Select FTP from the ‘Type’ drop-down list box.
5. Enter the system name of the workstation where you created the shared folder. Find the

system name of the workstation on the control panel of the workstation (Control panel
- Network - Identification - System name)

6. Enter the system name of the remote location and click 'Find' to identify the system lo-
cation easily.

7. Enter the path name. This is the name of the shared folder on your workstation. For
Windows NT®, Windows® 2000 and XP, use the DOS name of the shared folder. For
Windows 95/98® use the folder name. This is case sensitive.

8. For access to the directory on the workstation through FTP, a user name and password
is set on the FTP server that runs on the workstation. Enter this user name and this
password in the required fields on the properties window.

9. Set the required file naming properties
10. Click Ok.

The Power Logic® controller application connects to the new FTP destination. The 'Scan
jobs' view area then shows the contents of the new FTP destination.

Note:
You can create up to 10 destinations. Names in Japanese can only be entered for remote
destinations in SMB.

Lock a scan destination

1. Select a scan destination.
2. Open the ‘File’ menu and select 'Properties'.
3. Check the ‘Locked’ check box.
4. Click Ok to accept the scan destination settings.

The destination properties are now locked.

Note:
This option is only available if you are logged on as a key operator.

Unlock a scan destination

1. Select a scan destination.
2. Open the ‘File’ menu and select 'Properties'.
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3. Uncheck the ‘Locked’ check box.
4. Click OK to accept the destination settings.

The destination properties are now unlocked.

Note:
This option is only available if you are logged on as a key operator.

Delete a scan destination

1.    Select a destination.
2. Open the ‘File’ menu and select 'Delete' or click the 'Delete' button in the toolbar.

The selected scan destination is deleted.

Note:
You are not able to delete the last scan destination.
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Scan jobs tasks

Introduction

The 'Scan jobs' workspace in the Océ TC4 Power Logic® controller application allows
you to configure and manage the scan job settings and the scan destinations. In addition
you can manage your scan jobs workflow. You only set up your scan workflow once.
Thereafter, the main tasks in the scanning process take place at the scanner where you
define the individual scan job settings.

Scan destinations

Actions
■ Create, edit, delete scan destinations on the controller and on the network
■ Create protected scan destinations (only possible for authorized user: key operator)

Scan-to-file jobs

Actions
■ Define the settings for automatic file naming
■ View scanned files stored at various destinations
■ Check the properties of a scanned file
■ Delete scanned files
■ Resend scanned files
■ Send scanned files to another destination
■ Retrieve files via FTP
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Define file names

Introduction

You can define the file names in the following two methods.

1. by automatic file number definition for all originals in the scan-to-file job
2. by manual file name definition per original in the scan-to-file job.

Illustration

Automatic file number definition

1. Select a destination in the 'Scan jobs' workspace.
2. Open the ‘File’ menu and select ‘Properties’. The ‘properties’ window appears.
3. Enter a name in the ‘Base name’ text box. Do not change the ‘###’ part, this part is used

for automatic file name numbering. Océ Scan Logic replaces ‘###’ by an ascending
number. You can put dots in the ‘Base name’.

4. Check or uncheck the check box ‘Add the appropriate file extension’ to add or leave out
the file extension. Set the file extension in the 'Preferences' workspace of the Power Logic®

controller application.
5. Enter the start value for the automatic file naming in the ‘Start value for ###’ field.
6. Click ‘Ok’ to accept the file naming properties.
7. Scan the originals. You can scan now with automatic file name numbering. Select the

above destination on the scanner operator panel and set all scan-to-file properties. While
you scan, the scanner operator panel displays the file name.

Chapter 2 - Use the Océ TC454

Define file names



Manual file name definition

1. Select a destination in the 'Scan jobs' workspace.
2. Open the ‘File’ menu and select ‘Properties’. The ‘properties’ window appears.
3. Check or uncheck the check box ‘Add the appropriate file extension’ to add or leave out

the file extension. Set the file extension in the 'Preferences' workspace of the Power Logic®

controller application.
4. Enter a name in the ‘Base name’ text box. Remove the ‘###’ part, this part is used for

automatic file naming. You can put dots in the ‘Base name’.
5. Click ‘Apply’ to accept the destination properties. The ‘properties’ window stays open

and is ready for the next scan-to-file action after the current original is scanned.
6. Scan the original.
7. Repeat step 4, 5 and 6 for each original.
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View the properties of the scanned file

Purpose

Check the properties of a scanned file.

Before you begin

Make sure you have sufficient permissions when you log on to the Océ TC4 Power
Logic® controller application.

■ 'Anonymous' - permission, editing and other actions are allowed
■ Repro operator - permission, editing and other actions are allowed
■ Key operator - permission, editing and other actions are allowed
■ System administrator - permission, editing and other actions are allowed

How to view the scanned file properties

1. Click 'Scan jobs' in the vertical icon toolbar on the left hand side of the screen.
2. Select a remote or a local destination.
3. Select a scanned file in the right-hand section of the workspace.
4. Right-click the scanned file and select 'Properties'.
5. The properties window displays the file name, file size, type and location information.

In addition the image size and resolution is also displayed.
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Delete scanned files

Purpose

Delete scanned files from a selected local scan destination.

When to do

■ You do not want to keep the scanned file.
■ You want to clean up a local scan destination.

Before you begin

Make sure you have sufficient permissions when you log on to the Océ TC4 Power
Logic® controller application.

■ 'Anonymous' - permission, editing and other actions are allowed
■ Repro operator - permission, editing and other actions are allowed
■ Key operator - permission, editing and other actions are allowed
■ System administrator - permission, editing and other actions are allowed

Note:
You cannot remove scanned files stored at a remote location.

How to delete a scanned file

1. Click 'Scan jobs' in the vertical icon toolbar on the left hand side of the screen.
2. Select a local scan job destination in the 'Scan destinations'.
3. Select the job(s) you want to delete in the 'Scan jobs' view area in the left hand side of

the screen.

Note:
Make sure that you select one or more scan jobs. If you select the scan job destination,
the 'Delete' action removes the (local) scan job destination instead of the scan job(s).

4. Click 'Delete' in the toolbar of the 'Scan destinations' or right-click and select 'Delete'
from the drop down menu.

5. Repeat these actions for each scanned file that you want to delete.

Chapter 2 - Use the Océ TC4 57

Delete scanned files



Resend scanned files from the Unsent scans folder

Purpose

To send scanned files that could not be delivered to their initial destination to the same
destination.

Before you begin

Make sure you have sufficient permissions when you log on to the Océ TC4 Power
Logic® controller application.

■ 'Anonymous' - permission, editing and other actions are allowed
■ Repro operator - permission, editing and other actions are allowed
■ Key operator - permission, editing and other actions are allowed
■ System administrator - permission, editing and other actions are allowed

How to send scanned files from the Unsent scans folder to the same destination

1. Click 'Scan jobs' in the vertical icon toolbar on the left hand side of the screen.
2. Select the Unsent scans folder.
3. Select a scanned file and click 'Send' in the toolbar.
4. The document will be resent from the Unsent folder to its initial destination.

Result

If the destination cannot be reached, the scanned file remains in the Unsent scans folder.
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How to retrieve scanned files via FTP

Introduction

The scanned files are stored in the logging directory of the controller. You can retrieve
your files from the local host via File Transfer Protocol (FTP). FTP retrieval can be done
in the following ways.

■ Via an internet browser
■ Via an FTP application, or
■ Via a command line prompt.

When you scan to file, your files will be stored in the destination you set. This can be on
the local controller (1) or on a remote system (2). You can retrieve your files from the
local host via File Transfer Protocol (FTP). Also if during scanning to a remote destination,
something goes wrong, you can retrieve your files from the local host.

1
2

[35] How to retrieve scan files

Chapter 2 - Use the Océ TC4 59

How to retrieve scanned files via FTP



Retrieve files via an FTP command line prompt

1. Launch an FTP client.
2. Enter the ‘FTP’ command.

A DOS box now appears with the FTP prompt.
3. Enter the ‘Open’ command followed by either the registered name of the Océ Power

Logic® controller or the IP address (for example: 194.2.66.146) to connect to the controller
and press Enter: ‘open 194.2.66.146’.
The connection with the controller is now established and a window appears asking you
for a user name.

4. Enter your user name ‘Anonymous’, and enter as your password also ‘Anonymous’.
A connection is now set up for the default user ‘Anonymous’.

5. Set the transmission mode to binary by entering ‘Binary’.
6. Go to the ‘Tempstore’ directory using the following command: ‘cd tempstore’.
7. Go to the ‘Scan’ directory if you want to retrieve a file from a destination on the local

host,
or
go to the ‘Unsent’ directory if you want to retrieve a file from ‘Unsent’ folder on the local
host.

8. Get the data file (for example: bugatti.tif) via the ‘Get’ command.
9. Quit FTP by entering the ‘bye’ command.
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Océ View Station LT®

View locally scanned files with Océ View Station® LT

Introduction

With the use of the software application (Océ View Station® LT) you can automatically
view a file after scanning or you can view a locally stored scanned file. You can configure
the settings for Océ View Station® LT in such a way that the scanned file is opened auto-
matically.

Purpose

Check the quality of the scanned file before you archive the scanned file.

Before you begin

Make sure you have sufficient permissions when you log on to the Océ TC4 Power
Logic® controller application.

■ 'Anonymous' - permission, editing and other actions are allowed
■ Repro operator - permission, editing and other actions are allowed
■ Key operator - permission, editing and other actions are allowed
■ System administrator - permission, editing and other actions are allowed

Note:
It is not possible to view scanned files that are stored at a remote location.
You cannot use Océ Power Logic controller Remote to view scanned files.

How to view a file automatically after scanning

1. Open the Océ TC4 Power Logic® controller application.
2. Open the 'System' menu and select Autoview.

Result

When you scan to file the next time, Océ View Station® LT will start up a secondary
window and show the scanned file. If the autoview function is not enabled you can use
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the view button in the Océ TC4 Power Logic® controller application to open the secondary
window manually. The procedure below describes this action in detail.

How to view a locally stored scanned file

1. Access the Océ TC4 Power Logic® controller application.
2. Click 'Scan jobs' in the vertical icon toolbar on the left hand side of the screen.
3. Select a local destination.
4. Select a scanned file in the right hand section of the workspace.
5. Click the 'View' button in the toolbar to display the scanned file in the right hand section

of the workspace.
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Functions in Océ View Station® LT

Menu options
File menu#

What does it doCommand

Closes the active document.Close

Provides technical information about, and allows you to change
certain properties of, the document.

Properties

View menu#

What does it doCommand

Scales the image to fill the window.Fit

Displays the image at a 1:1 scale factor.1:1

Zooms into the page.Magnify

Zooms out of the page.Reduce

Redraws all windows displaying the active document.Refresh

Reverses the black and white parts of the image.Invert

Mirrors the image.Mirror

Rotates the image 90 degrees counterclockwise.Rotate 90
CCW

Rotates the image 90 degrees clockwise.Rotate 90 CW

Rotates the image 180 degrees.Rotate 180

When active, displays only a sample of bilevel raster pixels.Sample

Reverses the raster image pixels on display and changes which are
dominant for scaling.

Negate

When active, displays the active bilevel raster image as though it
were a grayscale image.

Scale to gray

An image or screen having only background and foreground colors.
Same as black-and-white or bilevel.

Monochrome

Preference menu#

What does it doCommand

View toolbar displays and removes the toolbar that contains buttons.
The View toolbar appears, by default, below the menu bar. It serves
as a fast means of selecting some File, View, and Preference menu
commands.

View toolbar
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What does it doCommand

Status Bar displays and removes the Status Bar at the bottom of the
Océ View Station LT window. The Status Bar displays the pointer
coordinates and a status line.

Status bar

Reference displays or removes a small, usually floating window. This
window displays the entire current page in miniature. The crossed
box inside the Reference window indicates which part of the page
is displayed in the document window. By moving or resizing the
crossed box, you change which area of the page is displayed.

Reference

Displays or removes the Detail window.Detail

When active, it allows you to measure lines and areas on the image.Measurement

Help menu#

What does it doCommand

Shows information about Océ View Station LT.About

Toolbar options

Below the menu options you find the function buttons in a toolbar. This toolbar can be
turned on and off.

  1      2      3    4     5       6     7     8     9     10   11   12

[36] toolbar options

#

DescriptionNr

Invert: Reverses the black and white parts of the image.1

Fit: Scales the image to fill the window.2

1:1: Displays the image at a 1:1 scale factor.3

Magnify: Zooms into the page.4

Reduce: Zooms out of the page.5

Mirror: Mirrors the image.6

Rotate 90 CCW: Rotates the image 90 degrees counterclockwise.7

Rotate 90 CW: Rotates the image 90 degrees clockwise.8

Rotate 180: Rotates the image 180 degrees.9
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DescriptionNr

Measurement: When active, it allows you to measure lines and areas
on the image.

10

Reference: This small floating window displays the entire current page
in miniature for reference.

11

Displays or removes the Detail window.12
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View error in Océ View Station® LT

When the memory is almost full it can occur that the viewer does not show the scanned
file. Instead it shows a red border with a red cross.

[37] View error
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Introduction to Océ Power Logic® controller Remote

Use the Océ Power Logic® controller Remote to access the Océ TC4 Power Logic®

application

In order to access the Océ TC4 Power Logic® controller application from a remote
workstation (e.g. when you have bought a system without a monitor, mouse and keyboard)
you must use Océ Power Logic® controller Remote to connect to the controller.

You can use Océ Power Logic® controller Remote to access the following workspaces
from a remote workstation.
■ 'Scan jobs'

Use this workspace to manage your scan jobs and scan destinations.
■ Scanner 'Templates'

Use this workspace to manage the scanner templates.
■ 'Preferences'

Use this workspace to change the default settings of the system.
■ 'Configuration'

Use this workspace to set all the connectivity and security settings.

Note:
Certain functions cannot be used when you logon remotely to the Océ TC4 Power
Logic® controller application e.g. scan-to-file viewing with Océ View station LT or using
the Océ Publisher Copy option.

User modes

The Océ TC4 Power Logic® controller application has different user modes. ‘The Océ
TC4 users’ on page 20. An additional user mode is the Océ Service mode. This mode is
for the Océ service technician only. You can check in which user mode you are logged
on because the user name is displayed in the left hand side of the status bar at the bottom
of the screen.
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Install and start Océ Power Logic® con-
troller Remote

Install Océ Power Logic controller Remote on your system

Introduction

The Océ Power Logic controller Remote application can run on all platforms with Java™
Virtual Machine. This section describes the installation procedures for the different types
of platforms.

Before you begin

To install Océ Power Logic controller Remote on Windows® 9.x, NT, ME, XP, or 2000,
your system must be at least equipped with a Pentium® 233 with 32 Mb RAM.

Note:
The file name remlogic, used in the installation procedure below is an example. It can
occur that you need to use another name during the installation procedure.

Installation procedure for Microsoft® Windows® platforms

1. Insert the Océ Power Logic® controller Remote CD-ROM or the Océ Power Logic®

controller CD-ROM into the CD-ROM drive of your PC.
2. The installation starts automatically. If it does not start automatically, run Setup.exe.
3. Select the required language in the installation wizard and click 'OK'.
4. Follow the instructions on the screen to complete the installation of Océ Power Logic®

controller Remote.

Note:
You can only use Océ Power Logic controller Remote when TCP/IP is enabled on your
system. Ask your system administrator for help with the installation procedure for TCP/IP.

Installation procedure for UNIX™ platforms

1. Check if a Java™ Runtime Environment (JRE) is installed on the system.
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2. From the directory Products/remlogic/Unix, unpack the contents of the file remlog-
ic_vX.tar to a subdirectory on the system.

3. Use tar xvf remlogic_vX.tar to unpack the file.
4. Set the environment variable RL_VM_HOME to point to the installation of the JVM.
5. Run the file remlogic.

Installation procedure for other platforms

1. Install Java™ Virtual Machine (version 1.4.2).
2. From the Océ Power Logic controller Remote CD-ROM, load remlogic_vX.tar or

remlogic_vX.zip.
3. Set the environment variable RL_VM_HOME to point to the Java™ Products/remlog-

ic/UNIX installation directory.
4. If necessary, edit the Océ Power Logic controller Remote script or batch file.
5. Use the Océ Power Logic controller Remote script or batch file to start the applications.
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Start the Océ TC4 Power Logic® application with Océ Power
Logic controller Remote

Introduction

Use the following 2 methods to start the application with Océ Power Logic controller®

Remote.
■ Use the programs menu of your operating system.
■ Use a command line parameter.

Use the programs menu to start the Océ Power Logic® controller application

1. Select 'Start'.

2. Select 'Programs'.

3. SelectOcé Power Logic controller application Remote.

The application starts with your default system.

Note:
You can select another system than your default system ‘Connect to the controller’ on page
74.

Use command line parameters to start the applications

Six command line parameters are available to facilitate the start of the applications.

■ configfile=<config_file>
Sets the configuration file to use.

■ server=server
Sets the indicated server as the server to connect to.

■ language1=lang
Specifies the first language in combination with the parameter language1=language.

■ country1=country
Specifies the first language in combination with the parameter country1=country.

■ language2=lang
Specifies the second language in combination with the parameter language2=language.

■ country2=country
Specifies the second language in combination with the parameter country2=country.

Note:
Always use a matching combination of language and country (see the following table).
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Parameters of supported languages
Parameters of supported languages#

Country parametersLanguage parametersLanguage

DKdaDanish

SVsvSwedish

NOnoNorwegian

FIfiFinnish

HUhuHungarian

CZcsCzech

POplPolish

DEdeGerman

NLnlDutch

GBenUK English

USenUS English

FRfrFrench

ITitItalian

ESesSpanish

PTptPortuguese

CNcnChinese simplified

TWcnChinese traditional

JPjaJapanese

RUruRussian

KOkrKorean

Apply the parameters to the Océ Power Logic controller Remote application

Apply the parameters to the following application: Power Logic® controller application
remote.exe
The easiest method to apply the parameters to the application is to create a shortcut for
the application. Then add the command line properties.

Note:
The .exe file is usually located in C:\Program Files\Power Logic Controller Re-
mote\Bin\OceRemoteLogic.exe.
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Example of a command line parameter

The example below shows how to start the controller applications with the configuration
file 'Myconfig.cfg', connected to the 'MyTC4' server. The first language is set to UK
English and the second language is set to French.

C:\Program Files\Remote Logic\Bin\AL.exe
configFile=Myconfig.cfg server=MyTC4 language1=en country1=GB language2=fr
country2=FR.
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Connect to the controller

Introduction

After you start Océ Power Logic® controller Remote, you must connect to the Océ TC4
Power Logic® controller.

You can do the following when you connect to the controller.
■ Select a system from the drop-down list.
■ Add a system to the drop-down list.
■ Remove a system from the drop-down list.

When the Océ TC4 is not available in the 'Connect to' window, you must add the Océ
TC4 to the list of available systems.

How to connect to a system

1. Run the application.
2. From the 'File' menu, select 'Connect to'.
3. Select the system from the drop-down list.
4. Click 'OK'.

Note:
From the 'Edit' menu, select 'Options' to define the default system. This is recommended
if you frequently connect to the same system.

How to add a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.

The 'Edit systems' dialog box appears.
3. Enter the IP address or the name of the system in the 'Systems' box.
4. Click 'Add'.

The system is added to the list.
5. Click 'OK' 2 times to return to the application.

How to remove a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.
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The 'Edit systems' dialog box appears.
3. Select the system you want to remove.
4. Click 'Remove'.

The system is removed from the list.
5. Click 'OK' 2 times to return to the application.
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Use Océ Power Logic® controller Remote

Automatic logon

Introduction

The 'Automatic logon' option enables you to start an application automatically in the
indicated user mode.

How to enable automatic logon

#

ActionStep

Access Océ Power Logic controller Remote.
From the 'Edit' menu, select 'Options'.
The 'Options' window appears.

1

Make sure that the Host name and Default system are config-
ured correctly otherwise you cannot connect to the controller.

2

Select the 'Enable automatic logon' checkbox.3

From the drop-down box, select the user mode for the automatic
logon.

4

Enter the password that corresponds to the selected user mode.5

Click 'OK'.6

Automatic logon is now enabled.
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Log on to Océ Power Logic® controller Remote
User modes

The Océ TC4 Power Logic® controller application has the following user modes.
■ Repro operator
■ Key operator
■ System administrator
■ Océ Service.

Only assigned operators are allowed to use the user modes. Different passwords are required
to access the user modes.
You do not need a password for the anonymous user mode.

Passwords

■ The default password for the system administrator is SysAdm.
■ The default password for the repro operator is  RepOp.
■ The default password for the key operator is KeyOp.

It is advised to change the default passwords to prevent unauthorized access. When a user
is logged on, the user can change the password for the current user mode. ‘Change the
'Password'’ on page 79

Note:
The passwords are case sensitive.

Authorization

There can only be one system administrator, key operator or repro operator active at a
time in the application. Only one user at a time that is logged on in a certain user role is
authorized to change the settings. An error message appears when a second user tries to
log on in a certain user role. There is no limitation of users authorized to view the settings.

How to log on to the controller application

1. Select the 'Log on' menu to access the logon dialog box.

2. Select the required user name.

3. Enter the password.

4. Click 'OK'.
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You are now logged on as special user. When you are not logged on, you have 'Anonymous'
user permissions.

The status bar at the bottom shows the user mode. The logon is limited to one user only.

How to log off from the controller application

Select the 'Log on' menu and choose 'Log off'. You return to the anonymous user mode.
Log off from the controller application to prevent unauthorized use.
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Change the 'Password'

Illustration

How to change the password

1. Select the 'Log on' menu in the toolbar to log on to the system.
2. Click 'Password' in the dialog box.
3. Open the drop-down list and select a user.
4. Enter the old password.
5. Enter the new password.
6. Enter the new password a second time to confirm.
7. Click 'OK' to save the new password.

Chapter 3 - OcéPower Logic® controller Remote 79

Change the 'Password'



Chapter 3 - OcéPower Logic® controller Remote80

Change the 'Password'



Chapter 4
The Océ TC4 Power Logic®

controller application



Introduction

The Océ TC4 Power Logic® controller software application

Definition

The Océ TC4 Power Logic® controller offers one integrated software application that
contains separate work spaces for users that have different permissions and tasks. The
users can access their workspaces on the controller or through remote access.
The big advantage of this integrated application is that it combines a number of indepen-
dent software applications into one powerful application. You only need to logon to one
application to have all functionality at your disposal.

Illustration

[41] Scan jobs screen
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The software application on the Océ TC4 Power Logic® controller

The software application on the Océ TC4 Power Logic® controller allows users to perform
different tasks, depending on the role they choose to log on.
The software application offers the following tasks in separate workspaces, accessible
through the vertical icon toolbar in the left hand side of the screen (see illustration above).

#

DescriptionWorkspace

Scan job management.'Scan jobs'

Scan templates management.Scanner 'Tem-
plates'

System settings management.'Preferences'

Network management and connectivity settings.'Configura-
tion'

Optional accounting module for tracking of costs.Océ Account
Logic
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Toolbars and workspaces

Introduction

The Océ TC4 Power Logic® controller application is divided in a number of workspaces.
After you have logged on, you can access the workspaces. Each workspace is divided in
smaller areas with specific functions.

The workspaces can be managed with the functions in the various toolbars. You can also
use the top toolbar menu options to manage the workspaces. The status bar displays
messages and icons to give the user for example status information about the Océ TC4.
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Illustration

Available toolbars
#

DescriptionToolbar

Top menu bar
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DescriptionToolbar

Manage the general application functions.
Available toolbar menus.
■ 'File'
■ Edit
■ 'View'
■ 'System'
■ Scan
■ 'Log on'
■ 'Help'.

Note:
Each menu contains a dynamic group of options. De-
pending on the workspace you access, certain options
can be displayed or hidden.

Access the different workspaces.
Available workspaces.
■ 'Scan jobs'
■ Scanner 'Templates'
■ 'Preferences'
■ 'Configuration'
■ Océ Account Logic (optional)

Vertical icon tool-
bar (Launcher)

Perform actions in each workspace or area within a workspace.

Note:
you can also right-click in the area to access a menu
with the options available in the toolbar.

Various toolbars in
the workspaces

Give feedback on the status of the Océ TC4.
■ Controller status feedback
■ Log on information
■ Workspace status feedback
■ System control panel feedback.

Status bar

Available workspaces

When you have started the application you can access the workspaces via the vertical icon
toolbar. The user role with which you log on determines the read and write permissions
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for each workspace. Every user is allowed to view the workspaces and settings but not all
users can modify the settings or perform actions in the workspace.

You can resize the columns in the workspaces by dragging the table header separators.
You can also change the order of the columns by dragging a selected column header to a
new position.

#

DescriptionWorkspace

Manage scan destinations and scan jobs.
The workspace contains the following areas.
■ Local scan destinations on the controller
■ Remote scan destinations on the network
■ View area scan jobs

'Scan jobs'

#

DescriptionWorkspace

'System defaults' tab
■ 'Contact' settings
■ 'Regional settings'
■ Sleep mode and sleep timer settings
■ 'Scanner' settings
■ 'Scan cleanup' settings
■ 'Logging' settings

'Preferences'

#

DescriptionWorkspace

Manage the network connectivity, security settings and licenses.
'Network' tab
■ Power Logic® controller identification
■ 'TCP/IP'
■ 'FTP'
■ IPX/SPX

'Configuration'

'Security' tab
■ Normal
■ Medium
■ High
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Log on as a different user

Purpose

Each user has specific rights and authorizations to perform actions in the application. To
be able to perform an action in a workspace you must logon with the user role that has
read and write access.

Before you begin

Make sure that you are the only user that is logged on in the selected user role. If there
is another user active in the same user role, you only have read-access to the workspaces.
The first user who logs on in a certain user role always has read and write permissions.

How to log on as a different user

1. Click the Log on menu option in the menu bar of the Océ TC4 Power Logic® controller
application. A secondary window appears.

2. Select the required user role from the drop-down box.
3.    Enter the password.
4.    Click OK.

Note:
You can set a default logon role if you only want to log on as key operator for example.

Result

If you have entered the correct password, you are now logged on. The status bar at the
bottom of the screen displays the log on status. If the password is not correct, a message
appears that asks you to enter the correct password.
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Change the password

Purpose

For security reasons it may be useful to periodically change the default passwords.

Before you begin

There are 4 user roles and a service access mode in which you can log on to the system.
The default passwords for the 4 user roles are listed here. It is advisable to change the
passwords after the system is installed to avoid unauthorized use of the system.

■ 'Anonymous' - no password necessary
■ Repro operator - ReproOp
■ Key operator - KeyOp
■ System administrator - SysAdm

How to change the password

1. Click the Log on menu option in the menu bar of the Océ TC4 Power Logic® controller
application. A secondary window appears.

2. The drop-down box displays a user role already. if necessary select another user role.
3. Click the 'Password' button.
4. A second window appears where you need to fill in the new password.
5. Click ok to close the window and accept the changes.
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Concepts of the Workspaces

Concepts of the 'Scan jobs' and the 'Scan destinations'

Definition

A scan job is an analog document that is scanned in on the Océ TC4 scanner. The result
is a digital version of the analog document. You can save this digitized document to a
pre-defined destination (scan-to-file). The scan-to-file jobs that you create on the Océ
TC4 scanner appear in the 'Scan jobs' workspace in the Océ TC4 Power Logic® controller
application.

The 'Scan jobs' workspace is divided in three areas that manage the complete scan jobs
workflow.
■ 'Scan destinations' on the controller. Define and manage the local scan destinations.
■ 'Scan destinations' on the network. Define and manage the remote scan destinations.
■ 'Scan jobs' view area. View scanned documents or view or edit the properties of a

scanned document.

'Scan destinations' on the controller

In this area of the workspace you find the default destination of the scan jobs. By default,
all the scan jobs are stored on the controller. The default scan job destination cannot be
deleted.

Use the toolbar at the top of the 'Scan jobs' workspace to create, edit and delete the local
'Scan destinations' on the controller.

The 'Scan destinations' area also gives access to the Unsent scan jobs folder. These jobs
must go to a remote destination but cannot be delivered. The jobs are temporarily stored
in the Unsent scans folder on the controller.

'Scan destinations' on the network

You can create 'Scan destinations' at a remote location instead of at local destination on
the controller. The remote scan destinations area displays the remote destinations that
you create. The remote destination is a folder on a workstation that is accessible through
the network.

Use the toolbar at the top of the 'Scan jobs' workspace to create, edit and delete the remote
scan job destinations in the 'Scan jobs' history area.
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When you select a remote scan job destination the jobs that are stored at the selected
destination are displayed in the right hand side of the workspace, the 'Scan jobs' view
area.

'Scan destinations' view area

The 'Scan jobs' view area displays all the scan jobs that are stored at the selected scan
destination. The scan job view area can give access to the scan jobs at the local and remote
destinations. You can select a file from the list and view the file properties. Some properties,
for example the scan job name can be edited.

Use the toolbar at the top of the 'Scan jobs' workspace to delete, view, edit or send the
selected scan job(s).

Note:
Only a scan job that is stored at a local destination on the controller can be opened with
the view application Océ View Station LT®.
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Concept of the 'Scan destinations'

Definition

A scan destination is a storage area for scan-to-file jobs that you create on the Océ TC4.
The scan-to-file jobs are sent to a temporary storage area where you can access the jobs
for additional processing. You can create local scan destinations on the Océ TC4 Power
Logic® controller and you can create remote scan destinations on any networked PC
connected to the Océ TC4. Jobs that cannot be delivered to the indicated destination
are temporarily stored in the Unsent scans folder.
The default destinations 'On controller' and Unsent scans cannot be removed.

'Scan destinations'

The 'Scan destinations' area consists of 2 sections. The table below describes the 'Scan
jobs' workspace.

#

Description'Scan destina-
tions'

The following local storage areas can be present.
■ 'On controller'.
■ Unsent scans.

Destination on
controller

You can create a maximum of 10 storage areas (local and remote
destinations) on one or more networked workstations.

Remote destination
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Illustration

'Scan destinations' toolbar options

Note:
Some of the toolbar options have a dual function. You can use the options to perform
actions on the 'Scan destinations' and on the scan jobs that you have selected. The last
three options described below are only used to perform actions on the selected scan
job(s).

#

DescriptionOptions in the
'Scan jobs'
workspace

Create a new scan job destination.'New'
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DescriptionOptions in the
'Scan jobs'
workspace

■ Delete the selected scan jobs destination(s).
■ Delete the selected scan job(s) in the 'Scan jobs' view area.

Note:
You cannot remove scanned files that are stored at a
remote location.

'Delete'

■ View and / or edit the properties of a scan job destination.
■ View the properties of the selected scan job.

'Properties'

This option allows you to view a scanned file that is stored at
a local destination.

Note:
Files that are stored at a remote destination cannot be
viewed.

'View'

Use this option to send the selected scanned file(s) on the con-
troller to their initial destination. You cannot use this function
for scanned files that are located at a remote location.

Resend

Use this option to send the selected scanned file(s) on the con-
troller to another remote destination. You can only use this
function for scanned files that are located in the Unsent location

Send to

If you do not want to use the toolbar options, there are 2 alternative methods to perform
actions. You can use the menu options in the top toolbar of the Océ TC4 Power Logic®

controller application or you can right-click to access a menu to perform actions on the
selected scan destinations or scan jobs.

Chapter 4 - The Océ TC4 Power Logic® controller application94

Concept of the 'Scan destinations'



Concept of the 'Templates' on the scanner

'Templates'

With a template you can pre-define the settings you need for a scan job. This way you
can store a number of settings that are often used. The pre-defined settings are saved in
a template. The template can be selected on the scanner operator panel. The scanner
operator panel of the scanner offers 5 scan-to-file templates.
For each template you can define the following items.

Template details#

DescriptionName

Give each template a unique name.'Template
name'

Give additional information about the template and / or its settings.'Template de-
scription'

Allows you to display the settings in the order that you prefer. When
you can place the settings you use most often at the top of the list
you avoid the need to scroll through the list of settings.

'Top 5 set-
tings'

Allows you to set the values for each setting, used in the template.Individual set-
tings
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Concept of the 'Preferences' workspace

Definition

The 'Preferences' workspace allows you to define a number of overall workflow and system
settings that manage the behavior of the Océ TC4. These settings are usually set during
the installation and are not changed often after installation.

The 'Preferences' workspace consists of the following groups of settings.

Note:
Only the key operator has all rights to access and changes the settings in this workspace.

#

DescriptionGroup

Allows you to pre-define the values for the settings that
manage the functioning of the entire system
■ 'Contact' details
■ 'Regional settings'
■ 'Sleep mode timer' setting
■ 'Enable sleep mode' setting
■ 'Scanner' settings
■ 'Scan cleanup' settings
■ 'Logging' setting

'System defaults'
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Concept of the 'Configuration' workspace

Definition

The 'Configuration' workspace allows you to define a number of network and connectiv-
ity settings that manage the Océ TC4. These settings are usually set during the installation
and are not changed often after installation.

The 'Configuration' workspace consists of the following groups of settings.
You have to logon as system administrator to be able to edit the settings.

#

DescriptionGroup

Allows you to define the standard settings for the following
protocols.
■ 'TCP/IP'
■ 'FTP'
■ IPX/SPX

'Network' settings

'Security Level'
■ Low
■ Medium
■ High

'Security'
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Introduction

If you have access to an Océ ColorWave 600 printer, the Océ TC4 Power Logic® controller
application offers the Océ Publisher Copy option.

Note:
You need a license for the Océ Publisher Copy option.

This option allows you to send a scanned document directly to the Océ ColorWave 600
printer.
You can activate the Océ Publisher Copy workspace from the icon in the vertical toolbar
of the Océ TC4 Power Logic® controller application.

When you activate the new Océ Publisher Copy workspace for the first time, you must
enter the Host Name of the Océ ColorWave 600 printer you want to connect to.
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Overview of Océ Publisher Copy

The Océ Publisher Copy sections

When you access the Océ Publisher Copy workspace, the following sections are displayed.

#

DescriptionSection

The default settings section.
In this section you can configure the default Océ Publisher Copy settings.
■ Set the User preferences.

(see ‘'User Preferences'’ on page 104)
■ Change the printer.

(see ‘'Change printer'’ on page 105)
■ Change the default copy template.

(see ‘Print (copy) template definition’ on page 107)
(see ‘Set the default behaviour for the media selection’ on page 108)

■ Enable or disable 'Direct copy mode'.
(see ‘Enable or disable 'Direct copy mode'’ on page 111)

1
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DescriptionSection

The 'Copy job progress' section.
This section displays information about the progress of the copy jobs.
■ Overview of active jobs and job history.

(see ‘The 'Active jobs' section and the 'History' section’ on page 113)
■ Overview of the job status.

(see ‘Job 'Status'’ on page 115)
■ Track and manage submitted jobs.

(see ‘Track and manage a submitted job’ on page 117)

2

The Océ ColorWave 600 printer information section.
This section displays information about the Océ ColorWave 600 printer
that is used for your copy jobs.
■ the list of jobs in the print queue (with the job name and the job

owner)
■ the list of loaded media
■ the level of toner in the cartridges.

3
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The default settings section

'User Preferences'

Illustration

How to set the 'User Preferences'

1. Click 'User Preferences' in the Océ Publisher Copy default settings section (upper right
corner).

2. Select the 'Language' you want to apply to the client application.
3. In the 'Measurement unit' section, select 'Inch' or 'Millimeter'.
4. Click 'OK'.
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'Change printer'

Illustration

How to change the printer

1. Click 'Change printer' in the Océ Publisher Copy default settings section (upper right
corner).
The application is disconnected from the current printer.

2. Enter the Host Name of the Océ ColorWave 600 printer that must be used for your copy
jobs.

3. Click 'Login'.
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Change the default Publisher Copy print (copy) template

Illustration

How to change the default Publisher Copy print (copy) template

Attention:
The default Publisher Copy print (copy) template that you select here only defines the
default settings for the printer. You can change the scan template settings in the 'Templates'
workspace (See ‘Define a Publisher Copy scan template’ on page 120).

1. Click 'Change default copy template' in the Océ Publisher Copy default settings area
(upper right corner).

2. Select a different print (copy) template from the drop-down list
or
You can create, edit, rename and delete your own print (copy) template. (See also ‘Print
(copy) template definition’ on page 107)

3. Click 'OK'.
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Print (copy) template definition

Definition

In a print (copy) template you can define a set of default print settings for a copy job.

A built-in print (copy) template is provided by default (Océ Publisher Copy default
template). It cannot be changed or deleted.
You can create, edit, rename and delete your own print (copy) templates.
You can set any created print (copy) template as the default template.

Content of a template

In a template, you can define the default values for:

■ the specific settings of each 'File format'
■ the 'Image' settings ('Image orientation' and 'Legend position' - detailed in ‘ 'Image

Properties'’ on page 127)
■ the 'Media' settings (see ‘Set the default behaviour for the media selection’ on page 108)
■ the 'Layout' settings ('Orientation of the image on the media', 'Alignment' and

'Margins' - detailed in Layout settings on page 136)
■ the 'Rendering' settings ('Color mode' and 'Quality' - detailed in Rendering settings

on page 139)
■ the 'Finishing' settings ('Additional strips', 'Finishing options' and 'Delivery destination'

- detailed in Finishing settings on page 142)

The system will apply by default these rules and values to all documents of every new
job.

Illustration
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Set the default behaviour for the media selection

Definition

In the 'Media' section of a template, you define the way the system will behave when se-
lecting a media for a document.

Media settings

Define the system behaviour regarding:

■ The 'Media type' selection
■ The 'Media size' selection
■ The 'Media source' selection

The lists in 'Media type' and 'Media size' subsections display the media enabled on the
printer. In these lists, each media marked with a green tick is actually loaded on the
printer.
The size of the rolls, the size of the standard sheets and the type of media displayed in
the lists are the sizes enabled on the printer (they can be actually loaded or not on the
printer).

'Media type' selection

Define the 'Media type' selection criteria:

#

Select from the list the media (type and size) to be used by
default.
If the selected media is not found when a document is
added to a job, the system displays a warning. You can then
edit the file and select another 'Media type' before printing.

'Request media type'

Select from the list the media (type and size) to be used if
available.
If the media of the selected type and of a correct size is not
found when a document is added to a job, the system pro-
poses another media of the correct size, of any other type.

'Prefer media type'

The system proposes a media of the correct size (of any
type).

'Use any Media Type'.
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Note:
When the template refers to a media type that has been disabled on the printer controller,
an error message is displayed: 'The selected media type is not available.'

'Media size' selection

'Automatic media size selection'

When you activate the 'Automatic media size selection', you keep a 100% scale and you
can decide to cut the media to the image size or to a standard sheet size:

■ 'Print at 1:1 scale and cut to image size' (default value)
■ 'Print at 1:1 scale on a standard sheet size'

'Manual Media Size selection'

When you activate the 'Manual Media Size selection', you can:

#

Scale the image to the width of a selected roll. Select the
roll size, taking the rotation settings into account.

'Scale to roll width'

Scale the image to fit a standard sheet size. Select the stan-
dard sheet size

'Scale to standard sheet
size'

Note:
When the template refers to a media size that has been disabled on the printer controller,
an error message is displayed: 'The selected media size is not available.'

'Media source' selection

When you add a file to a job, the system analyzes it and selects the most appropriate
media size for this document.
Choose whether it must:

#

The system picks the media from the list of all media en-
abled on the printer, even if the selected media is not
loaded on the printer.

'Select any enabled me-
dia'

The system picks the media from the list of media actually
loaded on the printer.

'Select loaded media
only' (default)

When the media is not available:

Chapter 5 - The Océ Publisher Copy option 109

Set the default behaviour for the media selection



■ In the 'Select any enabled media' mode, the system can select a media that is not
loaded.
When a submitted job requires an unloaded media, the job status turns into 'Waiting'
('Media not currently loaded on the printer.') and the job is held until you load the
needed media.

■ In the 'Select loaded media only' mode the system can select a media from an empty
roll.
When a submitted job requires a media from an (temporary) empty roll, the status of
the job turns into 'Waiting' ('Media not currently loaded on the printer.') and the job
is held until you load the needed media.

Note:
When the media is unavailable and the job is in 'Waiting' status, the name of one
missing media is displayed in a tooltip. Position the mouse over the job to display the
tooltip.
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Enable or disable 'Direct copy mode'

Introduction

You can enable or disable the 'Direct copy mode' by clicking the 'Direct copy mode'
button in the Océ Publisher Copy default settings section (upper right corner).

Illustration

#

ThenWhen

the scanned documents are printed auto-
matically with the document settings de-
fined in the copy template. You cannot
preview documents or edit settings in this
mode.

'Direct copy mode' is enabled
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ThenWhen

the scanned documents are collected in a
job. You can preview documents and edit
settings before printing.

Note:
It is advised to disable 'Direct
copy mode' when accounting is
requested on the printer. This is
to prevent that the user must en-
ter accounting information every
time a file is sent to the printer.

'Direct copy mode' is disabled
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The 'Copy job progress' section.

The 'Active jobs' section and the 'History' section

Illustration

As soon as a scan job is sent to the printer you can follow the progress of the job in the
system:
■ The status of the active jobs in the 'Active jobs' section.
■ The list of the completed jobs in the 'History' section (up to 50).

When available, the system displays also additional information on the status of a job
(see ‘Job 'Status'’ on page 115).

The 'Active jobs' section.

The 'Active jobs' section displays for each active job:

■ The job 'Name'
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■ The 'Status'
■ The 'Rank' in the printer queue
■ The 'Time' when the job was submitted to the printer
■ Additional 'Information' if available.

From this section, you can:

■ Configure the 'Job properties' (see ‘View the settings’ on page 118)
■ Reprint a job (see ‘Reprint a job’ on page 117).
■ Cancel a job (see ‘Cancel a job after submission’ on page 117).

Once the job is printed or canceled (or blocked in 'Error' status), it moves from the 'Active
jobs' to the 'History' section.

The 'History' section.

Each job submitted during a session appears in the 'History' section when it has reached
a final status. You can see:

■ The status of the job ('Printed', 'Error' or 'canceled')
■ The time when the job was printed out (after the print is finished) or when it reached

the final state
■ The name of the printer (in 'Information')

Once a job is in 'History' you can:

■ Configure the 'Job properties' (see ‘View the settings’ on page 118)
■ Reprint it (see ‘Reprint a job’ on page 117)
■ Remove it (see ‘Remove one or several jobs from the History’ on page 118)

To delete all jobs from the 'History', click the 'Clear History' button.

Note:
The 'History' section can store up to 50 jobs. Above 50, the oldest jobs are removed.
Only the jobs submitted by the user during the running session are displayed. If you
close and re-open the application or if you connect to another printer (see ‘'Change
printer'’ on page 105), the 'History' section is cleared.
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Job 'Status'

Introduction

Find below the list of possible statuses of a job. More details about the reasons of the
status are provided in the 'Information' field.

Job 'Status'
#

ThenIf the 'Status' of a
job is:

The job has been submitted and the data is not all received by
the printer.
A progress bar shows the progress of the data submission.

'Submitting'

The job has been completely submitted.
The position of the job in the printer queue is displayed.
It is still possible to cancel the job.

'Queued'

The job has been analyzed and the printer confirms that the
job is ready to print.
It is still possible to cancel the job.

'Ready to print'

The job is being printed.
Canceling the job may not abort the printing.

'Printing'

The printed output is available.'Printed'

The job is in attention state. The system is waiting for a human
intervention. The printer needs attention.

'Waiting'

The user has requested to cancel the job and action is not fin-
ished yet (the cancellation of the job has not been confirmed
by the printer).

'canceling'

The job has been canceled (in the application or on the 'Printer
operator panel')

'canceled'

One of the steps of the print process has failed.'Error'

The job is stored in the 'Smart Inbox'.'Stored'

Information on status

When available, additional information about the status of the job is displayed in the
'Information' field:
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#

ThenAnd the message is:When the 'Status'
is:

Load the required media onto
the printer or enter accounting
information at the printer before
the job can be printed.
When there are more than 1
reason why a job is waiting, the
main reason is displayed.

'Printer Waiting For Media'
or 'Waiting for accounting
information'.

'Waiting'

The job has been canceled by the
user in Océ Publisher Copy.
Reprint the job if needed.

'Job aborted by user or by
operator.'

'canceled'

The submission to the printer
failed or the printer has aborted
the job due to an error.
Check the connection to the
printer, check the availability of
the printer, and reprint the job

'Submission error' or 'Pro-
cessing Error - Job aborted
by system'.

'Error'

Note:
When the job is in 'Waiting' status because the media is unavailable, the name of one
missing media is displayed in a tooltip. Position the mouse over the job to display the
tooltip.
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Track and manage a submitted job

Introduction

From the 'Jobs' window you can track and manage a submitted job.

Attention:
To manage all jobs on the Océ ColorWave 600 printer go to the 'Jobs' tab in the Océ
Express WebTools.

View the status of a submitted job

1. Check the 'Status' of:
the current 'Active jobs'■

■ the current active jobs (in the 'Active jobs' section)
■ the completed jobs (in the 'History' section)

See the list of statuses and possible causes in ‘Job 'Status'’ on page 115.
2. See the additional information when available (in the 'Information' field).

Cancel a job after submission

1. In the 'Active jobs' section, select the job to be canceled,
2. Click 'Cancel job'.

The job status changes into 'canceling'.
Then the job appears as 'canceled' in the 'History' section.
The submission of the documents to the printer is stopped ('canceling' status). The job
is displayed with the 'canceled' status in the 'History' view.

Reprint a job

1. Select the job in the 'Active jobs' or 'History' section,
2. Click 'Reprint'.

The job is submitted to the printer (enter the accouting information if requested). It ap-
pears in the 'Active jobs' view.
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View the settings

1. Select the job in the 'Active jobs' or 'History' section,
2. Click 'Properties'.

In the 'Job Properties' window you can check and view the documents that compose the
job.

Remove one or several jobs from the 'History'

Note:
Only the jobs submitted by a user during the running session are displayed in the 'Jobs'
window. Therefore the user can cancel and remove only the jobs he submitted.

1. In the 'History' section, select the job or the jobs to be removed from the list,
2. Click 'Remove'.

Note:
To remove all the jobs from the 'History', click 'Clear History'.
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Copy settings related to the scanner

New scan destination

Introduction

Océ Publisher Copy adds a new default scan destination on your controller, called Pub-
lisher Copy. For copy jobs, you must select the Publisher Copy scan destination.

Illustration

To select the Publisher Copy scan destination you can do the following.
■ Select an existing template on the scanner operator panel, open the 'Destination' setting

and change it to Publisher Copy.
■ Access the 'Templates' workspace and replace an existing template with a Publisher

Copy template. (See ‘Define a Publisher Copy scan template’ on page 120).
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Define a Publisher Copy scan template

Before you begin

To define a Publisher Copy scan template, you must access the 'Templates' workspace.
The 'Templates' section displays an overview of the existing 'Templates on the scanner
operator panel' and the 'Template Library'.

Illustration

Define a Publisher Copy scan template

1. Create a 'New'Publisher Copy scan template.
or

■

■ Select an existing scan template from the 'Template Library' and 'Duplicate' it.
or

■ Select an existing scan template from the 'Template Library' and edit the 'Properties'.
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2. Edit or define the scan template settings. Make sure that you select Publisher Copy as
the 'Destination'.

3. Click 'OK' to confirm your entries.
4. Drag and drop the new Publisher Copy scan template on an existing scan template in

the 'Templates on the scanner operator panel' section. In the overview and on the scanner
operator panel, the existing scan template is immediately replaced by the new Publisher
Copy scan template.
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Do a basic copy job ('Direct copy mode'
enabled)

Basic copy job

Before you begin

Make sure that 'Direct copy mode' is enabled (See ‘Enable or disable 'Direct copy mode'’
on page 111).

How to do a basic copy job

1. Place the original face down and right aligned.
The scanner takes the original.

[56] Place the original face down and right aligned.

2. Select a Publisher Copy scan template or change the 'Destination' of an existing scan
template to Publisher Copy.

3. Change the scan settings if necessary and press the green start key.

Result

The scanner scans the original and sends the copy job directly to the Océ ColorWave
600 printer. The printer uses the print settings defined in the default copy template (See
‘Change the default Publisher Copy print (copy) template’ on page 106).
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Do an extended copy job ('Direct copy
mode' disabled)

Extended copy job

Before you begin

Make sure 'Direct copy mode' is disabled (See ‘Enable or disable 'Direct copy mode'’ on
page 111). Your copy job is not automatically sent to the printer. You can edit the print
settings before you send the copy job to the printer.

How to do an extended copy job

1. Place the original face down and right aligned.
The scanner takes the original.

[57] Place the original face down and right aligned.

2. Select a Publisher Copy template or change the 'Destination' of an existing template to
Publisher Copy.

3. Change the scan settings if necessary and press the green start key.
4. When the document is scanned a 'New Job' window opens. In the 'Job Composition'

section you can select your copy job and edit the print settings (See ‘The 'Edit Document
Print Settings' window’ on page 125).
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Note:
You can scan more than one original to the same job.

5. Click 'Print' to send the copy job to the printer.

Result

The scanner scans the original and you can adjust the print settings defined in the default
copy template (See ‘Change the default Publisher Copy print (copy) template’ on page 106)
before you send the copy job to the Océ ColorWave 600 printer.
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Edit and adjust the document print settings

The 'Edit Document Print Settings' window

Introduction

In the 'New Job' - 'Job Composition' window, select one or several documents.
Click 'Edit' to open the 'Edit Document Print Settings' window.

Illustration

In the 'Edit Document Print Settings' window, you can:

■ Select one document in the 'Document List' to display its properties, print settings
and 'Print Preview' (see ‘'Print Preview'’ on page 129).
When you select several documents simultaneously in the 'Document List', the system
displays only the settings values that are common to all documents. No preview is
then available.

■ Check and adjust the 'Image Properties' (see ‘ 'Image Properties'’ on page 127)
■ Tune the 'Basic' settings (see ‘'Basic' settings’ on page 130)
■ Tune the 'Advanced' settings:

- the 'Media' settings (see 'Advanced'/'Media' settings on page 133)
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- the 'Layout' settings (see ‘ 'Advanced' / 'Layout' settings’ on page 136)
- the 'Rendering' settings (see ‘'Advanced' / 'Rendering' settings’ on page 139)
- the 'Finishing' settings (see ‘ 'Advanced' / 'Finishing' settings’ on page 142).
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'Image Properties'

Introduction

In the 'Image Properties' section, you can describe the original image and control its display
in the preview.

If needed, check and adjust the:
■ 'File format' parameters
■ 'Image Orientation': the 'Reading orientation' and the 'Legend position'.

Note:
The system uses this information to define how to print and fold the image.

'File Format'

Click the 'File Format' button to display the file format and the related parameters, if
any.
You can modify the parameters if needed.

Note:
The availability of parameters depends on the format.

'Image Orientation'

Define the reading orientation of the original image. You can:

■ Keep the default setting: 'Match CAD standard' to orient the image according to the
selected standard.

■ Manually select the 'Reading orientation':
- 'Landscape': when the long edge of the image is the top of the image
- 'Portrait': when the short edge of the image is the top of the image

■ Use the rotation as it was saved in the original image by selecting 'No rotation (as in
file)'

If needed, check the 'Add a 180 degrees extra rotation' box to rotate the image by 180
degrees.
This option can be used with any of the orientation values.
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'Legend position'

When you set 'Automatic detection of the legend' in the default template, the system
analyzes the image to find the location of the legend (within the 'Timeout' limits). It
shows the selected corner in the 'Image Orientation' preview.
When needed, adjust the 'Legend position' to get the legend on top of the folded packet,
in case of folding. You can:

■ Keep the default setting: 'Match CAD standard' to place the legend according to the
selected standard:
- 'DIN': legend located at the bottom right of the image
- 'ERICSSON': legend located at the top left of the image
- 'AFNOR': legend located at the bottom right of the image

■ Manually select the 'Legend position' in the image by selecting a corner of the image.
■ Select 'No legend' when the document has no legend and will not be folded.
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'Print Preview'

'Print Preview'

The system displays an interactive preview to represent:

■ The way the system will print the image
■ The effects of the selected settings on the output.

Orientation of the image in the 'Print Preview'

The orientation of the image displayed in the 'Print Preview' depends on the 'Media size'
and cut method you select in the 'Media' settings:

#

ThenWhen

The 'Print Preview' displays the docu-
ment in its reading orientation.

You select a 'Sheet size', the printout is a
sheet of a standard dimension '(cut to a
standard size)'.

The 'Print Preview' displays the leading
edge of the media always at the top.

You select a 'Roll size', the roll is cut to
the size of the image '(cut to the image
size)'.

The preview shows:

■ a thumbnail view of the document, in color or B&W
■ the clipped area if any (in red)
■ the margins added to the image if any (blue dash line)
■ the image alignment (blue circle)
■ the part of the image that will be placed on top of the folded packet (in gray), when

folding is activated
■ the strips, if any additional leading or trailing strip (in light gray)
■ the direction of the paper feed (with the arrow)
■ the cut location
■ the system white space if any

Below the preview, the system displays the following file properties:

■ the scale factor (in percentage of the original size)
■ the size of the printed image
■ the media size on which it will be printed
■ the number of pages of the file
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Set the Basic and Advanced settings

'Basic' settings

Introduction

In this tab, you can view the general main settings of a document.

Illustration

'Media'

You can manually select in the lists the 'Media type' and the 'Media size' to be used.
The lists display all the media (type and size) enabled on the printer.
A roll status icon indicates if a specific media type on the printer is available, empty or
loaded.

When you select a 'Roll' in the 'Media size', the media is cut to the size of the image.
To cut to a standard sheet size, select a 'Sheet size'.
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Note:
If you select a media not loaded on the printer (or if the roll is empty) and submit the
job, the job status will turn into 'Waiting' ('Media not currently loaded on the printer.')
and the job will be held until you load the selected media.

Note:
'Warning' in case of folding: if the media you select does not support folding, an error
message is displayed. You must select a foldable media (type and size) or disable the
folding option to be able to print the job.

'Layout'

Define if the image is scaled or not. Select:

#

to keep the original image size.'1:1 Scale'

to define a custom scale value (from 1% to 1000%).'Custom scale'

for an 'Automatic scale down when image is larger than
media'

'Reduce to fit'

for an 'Automatic scale to the media size''Scale to fit'

'Finishing'

If a folder is declared in the print system, you can check the 'Fold' option.

Note:
When the selected media and print settings do not allow the folded output to be delivered
with the legend on top of the folded packet, a warning message is displayed ('The legend
will not be on top of the folded packet.').

The 'Delivery destination' depends on the printer capabilities and on the 'Fold' option.
To take delivery of an unfolded printout, select the 'Top Delivery Tray (TDT)' or the
'External output' at the back of the printer.
When folding is enabled and selected, the printout is automatically sent to the folder.
The 'Delivery destination' is automatically set to 'Folded delivery'.
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Note:
Some media types cannot be delivered to the 'Top Delivery Tray (TDT)' or to the
folder.
A media from a roll wider than 36 inches cannot be delivered to the folder.

'General'

Enter the number of copies of the document to print, between 1 and 999 ('Copy count').
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'Advanced' / 'Media' settings

Introduction

For each scanned original in the job, the system automatically selects the most appropriate
media to be used for printing, according to:

■ Automatically applies the default print settings defined in the template
■ The size of the image in the document
■ The folder value

You can manually pick out the media to be used if either:

■ When the system does not find an appropriate media
■ You want to use another media than the one selected by the application, or
■ When you have changed some print settings in the file (the 'Scale factor', the 'Orien-

tation of the image on the media '...).
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Illustration

'Media'

You can manually select in the lists the 'Media type' and the 'Media size' to be used.
The lists display all the media (type and size) enabled on the printer.
A roll status icon indicates if a specific media type on the printer is available, empty or
loaded.

When you select a 'Roll' in the 'Media size', the media is cut to the size of the image.
To cut to a standard sheet size, select a 'Sheet size'.

Note:
If you select a media not loaded on the printer (or if the roll is empty) and submit the
job, the job status will turn into 'Waiting' ('Media not currently loaded on the printer.')
and the job will be held until you load the selected media.
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Note:
'Warning' in case of folding: if the media you select does not support folding, an error
message is displayed. You must select a foldable media (type and size) or disable the
folding option to be able to print the job.

'Media information'

According to the media selected and the printer capabilities, the 'Media information' in-
dicates the 'Media source' to be used and the 'Media orientation' to be used.
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'Advanced' / 'Layout' settings

Introduction

You can define the layout of the image on the media.

Illustration

'Scale factor'

Define the 'Scale factor' if the image must be scaled on the printout. Select:

#

to keep the original image size.'1:1 Scale'

to define a custom scale value (from 1% to 1000%).'Custom scale'

for an 'Automatic scale down when image is larger than
media'

'Reduce to fit'

for an 'Automatic scale to the media size''Scale to fit'

'Orientation of the image on the media'

You can change the orientation of the output in the media by selecting either :
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■ 'Automatic': the orientation of the image is selected by the system in order to optimise
the position of the image, according to the settings defined ('Folding', 'Legend posi-
tion'...).

■ 'Manual', to manually define the orientation of the image on the media, according to
the media previously set in the 'Basic' or 'Media' tab.

#

You can decide to:When the 'Media size'
is:

'Print image short edge first': '<html>The short edge of the
image is aligned to the leading edge of the media.</html>
'

A 'Sheet size'

'Print image long edge first': '<html>The long edge of the
image is aligned to the leading edge of the media.</html>'

'Print image on a portrait sheet': '<html>The top of the
image is aligned to the short edge of the media.</html>'

'Print image on a landscape sheet': '<html>The top of the
image is aligned to the long edge of the media.</html>'

'Print image short edge first'A 'Roll size'

'Print image long edge first'

In all cases, you can select:

■ 'Upside down (extra 180° rotation)' to rotate the output by 180 degrees
■ 'Mirror'

'Alignment'

You can choose the way the image is aligned by selecting either:

#

Recommended for most users.
It is the best option when 'Orientation of the image on the
media' is set to 'Automatic'.
When folding is activated, the system aligns the image to
the corner of the media that will be on the top of the folded
packet.
When folding is off, it centers the image on the media.

'Automatic':

It shifts the selected side or corner of the image to the edge
of the media.

'Manual':
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'Adjust alignment':

You can change the alignment of the image on the media.
The reference is the image displayed in the 'Print Preview'. You can immediately check
the effect of the adjustment in the preview.

Activate the option and type in a value:

■ In the 'Horizontal' field, a positive value shifts the image to the right of media.
A negative is a shift to the left

■ In the 'Vertical' field, a positive value shifts the image to the top of media.
A negative is a shift to the bottom
You can set this value when you selected a 'Sheet size' as the 'Media size'.

'Add margins around the image'

Note:
By default, the application retrieves and applies the value set on the printer for each file
format ('Add margin around image').

Define whether the image to be printed needs additional margins. The additional margins
compensate for the non-printable area on the media.

If there are no margins (white space) arranged in the print file, select the 'Add margins
around the image' option.
This option adds an additional margin to each side of the print content in order to avoid
cropping.
You can configure the size of these added margins in the printer configuration tool (Océ
Express WebTools): from 3mm (default) up to 5mm (0.12 to 0.19 inch).

It is recommended to select this option when:
■ the content of the print file covers 100% of the file (no border) and the size of the

image is the same as the size of the selected media.
■ the content of the print file covers 100% of the file (no border) and the image is

smaller than the selected media.
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'Advanced' / 'Rendering' settings

Introduction

You can tune the color settings and rendering options.

Note:
For Océ Publisher Copy it is advised to define the following color settings.
■ 'Color mode': 'Océ enhanced colors'
■ 'RGB input data': 'sRGB'
■ 'Rendering intent': 'Relative colorimetric'

Illustration

'Color mode'

Define if the document is printed in Color or in Black and White.
When you select 'Color', you are invited to define the 'Color mode'. Select:

#

to use the default value set on the printer.'Printer's color feel'
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to use the color feel embedded into to the file. This
information was set by the application that created the
file.

'Document's color feel'

to manually finetune the combination of the color in-
put data and 'Rendering intent'. Click 'Edit' to open
the 'Edit Colors Settings' window and configure the
settings.

'Océ enhanced colors'

to finetune the rendering of the printed colors.a 'Predefined color feel'

'Color mode': 'Océ enhanced colors'

When the color feel is set to 'Océ enhanced colors', you can define the color settings for
the selected file:

Note:
The availability of the print settings depends on the format of the file.

Note:
For a file, the default value of each color setting is the default value defined for this type
of file.

■ the RGB data interpretation: 'sRGB' or 'Adobe RGB'.
■ the CMYK data interpretation: 'Euroscale coated', 'Euroscale uncoated', 'US Web

coated (SWOP)' or 'US Web uncoated'. This setting is not available for HPGL/2,
HPGL or HP-RTL files.

■ the 'Rendering intent': 'Perceptual (photo)', 'Saturation (business graphics)', 'Absolute
colorimetric', 'Relative colorimetric'.

'Quality'

Select the 'Quality' level to be applied:

#

to reduce the amount of toner used and produce lighter
images with less details.

'Economy'

for high productivity of good quality prints.'Production'

to create rich, detailed images but with a reduced pro-
ductivity.

'Presentation'
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to select the best print setting for each document, based
on the graphical content. It is configured on the
printer.

'Océ Print Assistant'
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'Advanced' / 'Finishing' settings

Introduction

The 'Finishing' options displayed depend on the printer available options.

'Additional strips'

You can add a 'Leading strip' or a 'Trailing strip' to correct the length of the output. The
adjustment of the edges changes the output format.
The 'Leading strip' adds a strip at the top of the printout (0 to 400 mm / 0 to 15.74 in).
The 'Trailing strip' adds a strip at the bottom (0 to 400 mm / 0 to 15.74 in).

Note:
The system displays the units ('mm'/'in') defined in the 'User Preferences'.

'Finishing options'

If a folder is declared in the print system, you can check the 'Fold' option.

The system uses the 'Image Properties' to fold the printout, in order to put the legend
on top of the folded packet.

Note:
When the selected media and print settings do not allow the folded output to be delivered
with the legend on top of the folded packet, a warning message is displayed ('The legend
will not be on top of the folded packet.').

The 'Delivery destination' depends on the printer capabilities and on the 'Fold' option.
To take delivery of an unfolded printout, select the 'Top Delivery Tray (TDT)' or the
'External output'/'Lower receiving tray' set at the back of the printer.
When folding is enabled and selected, the printout is automatically sent to the folder.
The 'Delivery destination' is automatically set to 'Folded delivery'.

Note:
Some media types (thick media) cannot be delivered to the 'Top Delivery Tray (TDT)'
or to the folder.
A media from a roll wider than 36 inches cannot be delivered to the folder.
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About Océ Licence Logic

Introduction

The Océ applications and options are protected against unauthorized use. You need to
activate the license to enable an application or option for use. Océ License Logic enables
you to manage the licenses very easily.

This section describes the following:
■ The basic concept of Océ License Logic
■ How to use Océ License Logic.
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The possibilities of Océ License Logic

Introduction

Océ License Logic has the following possibilities.

Possibilities

■ View the current active licenses
■ Get the host id of the Océ system
■ Save the active licenses
■ Perform a license activation job.

You can activate new licenses or saved licenses.
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The basic workflow of license activation

Introduction

Before you can use the possibilities of Océ License Logic, you must log on to Océ License
Logic. The following workflow describes per step when to use which possibility.

The workflow

1. Select the new options you need.
Use the following possibilities of Océ License Logic to do so.
■ View the current active licenses

You can make a list of new options you need and make a list of license numbers. Océ
needs the list of new options and the license numbers to create a new license file.

■ Get the host id of the Océ system.
Océ needs the host id of your Océ system to create a new license file.

2. Send the list of new options you need, the list of license numbers and the host id to Océ.
Océ creates and delivers one or more new license files.

3. Create a back-up of the current active licenses if necessary.
Use the following possibility of Océ License Logic to do so.
■ Save the current active licenses

4. Activate the licenses.
Use the following possibility of Océ License Logic to do so.
■ Perform a license activation job.

The license activation job guides you through the following steps.
1. Locate the license file
2. Preview the new active licenses
3. Accept the end user license agreement
4. Finish the license activation job
5. Restart the controller of the Océ system.

Note:
Perform the license activation job for each license file.
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The structure of license files and licenses

Introduction

A license file contains a license per option of your Océ system. You can view the current
active licenses with Océ License Logic. You can preview the new active licenses with Océ
License Logic during the license activation job.

A license file contains licenses of the same license-type

A license file you receive from Océ contains only licenses of the same license-type. The
following license type is possible.

■ Resale.

If you order a resale license, you receive 1 license file.

What you see per situation

What you see per situation depends on the license file you use.

What you see depends on the situation#

What do you seeSituation

You see the following.
■ All current active resale licenses
■ All current other not active options.

View the current active licenses.

You see one of the following options.
■ A resale license file

Océ delivered one or more li-
cense files.

You see the following.
■ All current active resale licenses
■ All new active resale licenses.

Preview the resale licenses during
the license activation job if you
use the license file that contains
the resale licenses.

You see the following.
■ All resale licenses that where active at the time

you created the back-up file

Preview the resale licenses during
the license activation job if you
use the saved licenses of your
back-up file.

You see the following.
■ All current active resale licenses
■ All new resale licenses
■ All current other not active options.

The license activation job is fin-
ished.
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Control your licenses with Océ License
Logic

Log on to Océ License Logic

Introduction

You can run Océ License Logic on the controller of the Océ system or remote through
a web browser. Access to Océ License Logic is password protected. Use the same network
administrator password as you use on the Océ system to log on.

Purpose

Log on to Océ License Logic for the following purposes.
■ View the current active licenses
■ Get the host id of the Océ system
■ Save the current active licenses
■ Perform a license activation job.

You can activate new licenses or saved licenses.

Before you begin

To run Océ License Logic remote, you need the host name or IP address of the Océ system.

How to log on to Océ License Logic on the Océ TC4 Power Logic® controller

1. Open the Océ TC4 Power Logic® controller application.
2. Click 'Edit' in the menu bar.
3. Click 'Licenses...'.

The logon window opens.
4. Select system administrator.
5. Enter the 'Password'.
6. Click the 'Logon' button.

How to log on to Océ License Logic from a remote web browser

1. Open the web browser.
Océ License logic supports Microsoft® Internet Explorer® version 5.5 or higher.
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Note:
URL is case sensitive

2. Enter the following URL in your browser: http://'scanner-name'/LicenseLogic.html.

Note:
'Scanner-name' is the host name or IP address of the scanner.

The logon window opens.
3. Select system administrator.
4. Enter the 'Password'.
5. Click the 'Logon' button.

Result

Océ License Logic starts with one of the following windows.

■ The 'No active license' window.
This window opens if there are no active licenses.

■ The 'View licenses' window.
This windows opens if Océ License Logic detects active licenses.

Note:
If the log on failed, Océ License Logic displays a message. Read the message carefully
and follow the instructions.
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View the current active licenses

Introduction

When you log on and Océ License Logic detects active licenses, the 'View licenses' window
opens and displays the current active licenses. Per option the following fields with license
information display.

■ 'Option'
This field displays the name of the option.

■ 'State'
This field displays one of the following license states.
- 'Authorized'
- 'Not authorized'
- 'Expired'
- 'Update configuration'

■ 'License type'
This field displays the license type.
- 'Resale'

■ 'Duration in days'
This field displays the time your license is valid.

■ 'License number'
This field displays a license number.

Purpose

View the license information for the following purposes.

■ Check the active licenses on license state, license type and license duration
■ View all options available for your Océ system.

The list of options depends on the type and version of the Océ system.
■ Make a list of new options you need
■ Make a list of license numbers.

When to do

View the license information to make a list of new options you need and to make a list
of license numbers.

Note:
If an error occurs, Océ License Logic displays a message. Read the message carefully and
follow the instructions.
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Before you begin

Make sure that the scan system has active licenses. If Océ License Logic does not detect
active licenses, the 'No active license' opens ‘Log on to Océ License Logic’ on page 148.

How to view license

1. Log on to Océ License Logic.

Result

The 'View licenses' window opens.
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Get the host id of the Océ system

Introduction

Océ needs the host id and the license numbers of your Océ system to create a new license
file.

When to do

Get the host id to order a resale license file from Océ.

Before you begin

Open a text editor on the same system that you start Océ License Logic. You can store
the host id in a document.

How to get the host id

1. Log on to Océ License Logic.
The 'No active license' window opens if there are no active licenses.
The 'View licenses' windows opens if Océ License Logic detects active licenses.

2. Click the 'Host id' link.
The 'The host id of your Océ system' window opens.

3. Click the 'Copy' button to copy the host id to the clipboard.
4. Open a new document in a text editor.
5. Use the paste option of the text editor to copy the host id into the document.
6. Enter the different license numbers into the document.
7. Save the document.

Result

The host id is stored in a document. You can use this document to send the host id and
license numbers to Océ.
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Save the current active licenses

Introduction

You can save all current active licenses of different licenses types into one single file.

Purpose

Save the current active licenses for the following purposes.

■ Collect and save all active licenses of different types into one single file
■ Create a back-up file before you start a license activation job.

When to do

Save the current active licenses before you start a license activation job or to save the
current license situation.

Before you begin

Make sure that the scan system has active licenses. If Océ License Logic does not detect
active licenses, the 'No active license' opens ‘Log on to Océ License Logic’ on page 148.

How to save the license

1. Log on to Océ License Logic.
The 'View licenses' window opens.

2. Click the 'Save' button.
The 'Save licenses' window opens.

3. Select a directory, enter the file name and click the 'Save' button to back-up the current
active licenses.

Result

All current active resale licenses are stored into one single file.
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Perform a license activation job

Introduction

You need to activate the licenses on the Océ system to enable an option for use. Océ de-
livers the new licenses through one or more license files.

Purpose

Activate the licenses for the following purposes.

■ Activate a new resale license to enable a new option
■ Activate the saved licenses of your back-up file to return to the saved situation.

When to do

Activate the licenses in the following situations.

■ Activate the new licenses when you have received one or more new license files from
Océ

■ Activate the saved licenses when an activation job for new licenses failed.

Before you begin

To activate the new licenses, you need a license file from Océ. Perform a license activation
job per new license file. Make sure you use the correct license file: the host id in the license
file must be the same host id as the host id on your Océ system. Make sure the license
file is available on the system you run Océ License Logic.

Note:
If an error occurs, Océ License Logic displays a message. Read the message carefully and
follow the instructions.

How to activate the licenses

1. Log on to Océ License Logic.
The 'No active license' window opens if there are no active licenses.
The 'View licenses' windows opens if Océ License Logic detects active licenses.

2. If the 'No active license' window opens, click the 'Next' button.
The 'View licenses' window opens.

3. Click the 'Activate' button.
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4. Click the 'Browse' button to select the location of the license file and click 'OK'
5. Click the 'Next' button

A preview of the new license situation displays. What you see depends on the license types
in the license file you use ‘The structure of license files and licenses’ on page 147. You see
one of the following options.
■ If you use a license file with resale licenses, the current active and the new resale licenses

display
■ If you use a saved file with resale licenses, resale licenses display like the time you cre-

ated the back-up file.

6. Click the 'Next' button.
The end user license agreement displays.

7. Read the end user license agreement carefully. If you agree, select ' I accept'.
8. Click the 'Finish' button to activate the license.

The 'View licenses' window displays.
9. Restart the controller of the Océ system.

Result

The licenses are active and the options are ready for use.
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An overview of Océ Account Center

Introduction

Use Océ Account Center to manage the account information of the scan-to-file jobs for
your Océ TDS and Océ TCS devices.

Definition

Océ Account Center consists of the following two software modules.
■ Océ Account Logic

Océ Account Logic runs on the Océ Power Logic® controller. You can connect to
Océ Account Logic from a remote workstation through a web browser.
The users use Océ Account Logic to enter the account information. The user can enter
the account information for the scan-to-file jobs. The users can enter the account in-
formation at the Océ Power Logic® controller and at the workstation.
The administrator can manage Océ Account Logic from the 'Administration' screen
on the application.

■ Océ Account Console.
Océ Account Console runs on a PC that functions as a server. You can connect to
Océ Account Console from a remote workstation through Internet Explorer. Access
to Océ Account Console application is password protected and limited to authorized
personnel.
The administrator uses Océ Account Console to create the 'Account information' di-
alog. The administrator publishes the 'Account information' dialog for Océ Account
Logic and other applications.
The bookkeeper uses Océ Account Console to retrieve and export the log data. The
bookkeeper uses the log data for accounting purposes.
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Illustration

User roles and tasks in Océ Account Center
User roles and tasks in Océ Account center#

TasksUsers

A) Create, manage and delete the account dialog.
B) Publish the account dialog to the Océ TC4 Power
Logic® controller.

1) Administrator

C) Use the dialog of Océ Account Logic to specify the ac-
count information for each scan-to-file job.

2) Users

D) Retrieve and use the account information of the scan-
to-file jobs that is stored on the Océ TC4 Power Logic®

controller. The log data serves as input for the accounting
reports and invoices.

3) Bookkeeper

Access to Océ Account Logic

Provided you have a valid license, you can access the application via the vertical icon
toolbar in the Océ TC4 Power Logic® controller application.

Actions to access Océ Account Logic.
■ Access the Océ TC4 Power Logic® controller application.
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■ Click the Océ Account Logic icon in the vertical icon toolbar.
A secondary, smaller window appears on top of the window of the Océ TC4 Power
Logic® controller application. Please note that when you click the screen in the back-
ground, the smaller screen with Océ Account Logic disappears to the background.
Minimize the screen in the foreground to retrieve the Océ Account Logic screen.

■ Access the file tab to define the accounting data for the scan jobs.
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Océ Account Logic®

Introduction to Océ Account logic

Introduction

Before you begin to use Océ Account Logic, you can change your setting in:

■ Océ Settings Editor on the Océ Power Logic® controller, or
■ Power Logic controller software application

Definition

Use Océ Account Logic to link account information to your job. The account information
requirements are defined and managed by the administrator.

Purpose

Use Océ Account Logic for the following.
■ Enter account information for the scan-to-file jobs
■ Lock and unlock the scanner
■ Administer Océ Account Logic (administrators only).
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Summary of Océ Account Logic

Sections

Océ Account Logic has the following sections.
■ The 'File' tab

Use this tab to enter account information for scan-to-file jobs.
■ The 'Administration' window.

Use this window to define the administrative settings for the application. Access to
this window is password protected and limited to the application administrator.
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Océ TC4 Power Logic® controller setup

Introduction

Before you begin to use Océ Account Logic, you must do the following.
■ Activate Océ Account Logic by activating the licence in Océ License Logic.
■ Check the correct settings in the Océ TC4 Power Logic® controller application. When

you have activated Océ Account Logic the relevant settings in the Océ TC4 Power
Logic® controller application will be set to the correct value.

Before you begin

Before you begin you can check and if necessary modify the correct settings in the Océ
TC4 Power Logic® controller application on the Océ TC4 Power Logic® controller ap-
plication, log on as a machine administrator.

Note:
Refer to the on-line help of the Océ TC4 Power Logic® controller application for infor-
mation about the settings and the location of the settings.

Note:
After an upgrade of Oce Account Logic all the administrative settings are maintained.
You can check the settings in the 'Administration' window.

The correct settings
#

ExplanationDefinitionThe path to the setting in
the Océ TC4 Power Logic®

controller application

The scanner locks when the scanner
panel timeout expires. The scanner
locks to prevent users from using
the scanner without entering ac-
count information. When you set
the timeout to a minimum value,
the scanner locks after a minimum
of time has passed.

Océ advises you
to set the panel
timeout to the
minimum value
(30 seconds).

Path: 'Preferences' - 'System
defaults' - 'Scanner' - 'Panel
time-out'
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Océ Account Console®

Introduction to Océ Account Console

Definition

Océ Account Console is installed on the administrator's workstation. Access to Océ Ac-
count Console is password protected and limited to the administrator.

Purpose

Use Océ Account Console is intended for the following actions.
■ Manage, preview, and publish the account information dialog for Océ Account Logic.
■ Retrieve and export the log files.
■ Manage the devices.

Note:
For this application a separate user manual is available.
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Summary of Océ Account Console

Main parts of Océ Account Console

An administrator uses Océ Account Console to perform a number of maintenance and
configuration tasks.
The main functional areas of Océ Account Console are described in the table below.

Main parts of Océ Account Console#

DescriptionPart

'Fields' section.
■ Create an accounting dialog. The accounting dialog consists

of a number of accounting fields.
■ Delete an accounting dialog. Please note that this action

cannot be reversed.
■ Edit an accounting dialog. You can change the type of ac-

counting field.
■ Change the order of the accounting field in the list.
■ Make a preview of the accounting dialog to test the validity.
■ Publish the accounting dialog. Make the accounting dialog

available to external applications.

'Values' section.
■ Create values for each accounting field.
■ Add values for each accounting field. You add existing values

to an accounting field.
■ Delete values for each accounting field. Please note that this

action cannot be reversed.
■ Edit values for the selected accounting field
■ Move the selected value up or down in the list.
■ 'Sort A..Z '. Use this option to organize the list in ascending

order.
■ 'Sort Z..A'. Use this option to organize the list in descending

order.

The 'Dialog' tab
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DescriptionPart

'Devices' section.
■ 'Create...'. Use this option to create a new device.
■ 'Delete'. Use this option to remove the device. The log data

for the device is removed as well. Please note that this action
cannot be reversed.

■ 'Edit...'. Use this option to change the values for a device.
■ 'Delete log data'. Use this option to remove log data of a

device.
■ 'Upgrade'. Use this option to upgrade Océ Account Logic.

'Tasks' section.
■ 'Compress database'. Use this option to clean up the

database.
■ 'Start'. Use this option to run an update dialog or to retrieve

log data.
■ 'Edit...'. Use this option to change the conditions for the

update dialog and the log data retrieval.

The 'Devices' tab

'Overview' section.
■ 'Create...'. Use this option to define the conditions to export

data
■ 'Delete'. Remove the export filter.
■ 'Edit...'. Change the conditions to export log data.
■ 'Run...'. Select the required filter and start the export of the

log data.

'Statistics' section.
■ 'Create...'
■ 'Delete'
■ 'Edit...'
■ 'Run...'

The 'Export filters'
tab

The license screen enables you to perform the following actions.
■ Determine the host ID necessary to receive a valid license

file.
■ Activate the license file.
■ Create a back-up of the license file.

The 'Licenses'
screen
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DescriptionPart

The administrator screen enables you to perform the following
actions.
■ Change the password.
■ Publish the data that are retrieved from other applications.
■ Define the remaining settings for Océ Account Console.
■ Set the regional settings

-Application language
-Units of measure (metric or imperial values)

The 'Administra-
tion' screen.
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Maintain the Océ TC4 scanner

Clean the scan area

Introduction

You need to keep the glass plate clean. A dirty glass plate causes a decreased scan quality.
Clean the glass plate when you have lines on the image that are not on the original.

Attention:
Use Océ cleaner A to get the best results.

Attention:
Make sure you do not damage the sensor at the right of the glass plate.

How to clean the glass plate

1. Turn off the Océ TC4 scanner.
2. Pull the top cover towards you and lift the top cover to open it.

[65] Open the top cover
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3. Clean the glass plate and the white plate with a lint-free cloth and a small quantity of the
cleaner.

[66] Do not damage the sensor at the right side in front of the glass plate.

4. Dry the glass plate and the white plate with another lint-free cloth.
5. Clean the white plate.
6. Lift the top cover, turn the top cover towards you and push the top cover down until you

hear or feel a click.
7. Turn on the Océ TC4 scanner.
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Calibrate the scanner

Introduction

You can calibrate the scanner when you are not satisfied with the scan quality. Use the
calibration wizard to calibrate the scanner.

Before you begin

Clean the glass plate clean before you start the calibration procedure ‘Clean the scan area’
on page 170. A dirty glass plate causes a decreased scan quality. Clean the glass plate when
you have lines on the image that are not on the original.

How to calibrate the scanner

1. Select 'System' with the lower-right softkey.
The 'System settings' screen opens.

2. Select 'Scanner calibration' with a left softkey to start the calibration wizard.
The message 'Insert calibration sheet' and the following icon appears.

[67] The 'Insert calibration sheet' icon

3. Insert the calibration sheet and press the green start key to start the calibration process.
The message 'Scanner is calibrating...' and the following icon appears.

[68] The 'Scanner is calibrating...' icon

When the calibration process is ready, the message 'Press OK to continue' and the follow-
ing icon appears.

[69] The remove the calibration sheet icon
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4. Select 'OK' with the lower-right softkey.

Note:
When the calibration process stops or fails, follow the instructions on the scanner oper-
ator panel carefully.

Result

The Océ TC4 scanner is calibrated and the scan quality is correct again.
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Clear an original jam on the scanner

Introduction

A red light at the scanner operator panel indicates that an original jam occurred.

How to remove a jammed original

1. Pull the top cover towards you and lift the top cover to open it.

[70] Open the top cover

2. Remove the original.
3. Lift the top cover, turn the top cover towards you and push the top cover backwards

until you hear or feel a click.

Result

The green light at the scanner operator panel is on.
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Scanner error-messages and solutions

Introduction

When an error occurs, the scanner operator panel shows the following information.
■ The error-message icon
■ The error message
■ A description of the solution
■ An error code
■ Functions at the lower softkeys.

In some cases you need these functions, like wind and rewind for example, to come
to the solution.

How to handle error messages at the scanner

1. Read the error message carefully.

[71] The error-message icon

2. Follow the instructions on the scanner operator panel.

Result

You solved the error with the help of the instructions on the scanner operator panel.
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Overview of the Océ TC4 system

Introduction

The Océ TC4 is a high quality and fast wide format color scanner for scanning engineering
documents. The Océ TC4 offers scan to file functionality. The scanner is available in the
following hardware and software configuration.

The scanner components

21

3

#

ComponentNr

Scanner1

Scanner operator panel2

Scanner feed table3

The Océ TC4 / Océ TC4XT scanner configuration

You can use the Océ TC4 scanner to scan originals with an original thickness up to 3
mm.
To scan thick originals up to 15 mm or rigid originals you can use the Océ TC4XT
scanner. This scanner is equipped with a handle that you can use to set the original
thickness.
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Scanner operator panel

scanner

1 2 3 4 5 6 7 8 9 0 

3 

5 

6 

11 

4 

1 2 

7 8 

10 

  9 

12 

#

ComponentNr

LED (green and red attention light)1

Display2

Upper softkey3

Scroll wheel key4
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ComponentNr

Scroll wheel5

Lower softkey6

Green start key7

Stop key8

Numeric keys9

Lower softkey10

Left softkeys11 / B

Upper softkey12
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Specifications of the Océ TC4

Specifications of the Océ TC4

Introduction

The Océ TC4 is a high quality and fast wide format color scanner for scanning engineering
documents. The Océ TC4 offers a scan-to-file functionality.

The table below gives you more information on the performance of the scanner, the
technical and safety requirements and general information regarding dimensions, weight,
power consumption etc.

Scanner
#

■ Océ Image Logic® real-time image processing
■ 1 x Reduction type CCD camera

Technology

Black&white
■ up to 5 m/min. or 3.3 inch/sec.

Grayscale & Color
■ up to 4 m/min. or 2.8 inch/sec.

Scan speed

575 dpiResolution

3 color linear CCD
21360 Pixels
24 bits color

Camera

914.4 mmScan width

Right alignedOriginal feed

Rigid/thick media scanner
Minimum
■ 210 mm x 210 mm (L x

W)

Maximum
■ 1300 mm x 965 mm (L x

W).

Standard scanner
Minimum
■ 210 mm x 210 mm (L x

W)

Maximum
■ 6000 mm x 1016 mm (L

x W).

Original size

15 mm1.5 mmMaximum media
thickness
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2.5 kg/m²not applicableMaximum media
weight

■ Width: 1,300 mm
■ Depth: 1,230 mm
■ Height: 1,300 mm

■ Width: 1,300 mm
■ Depth: 650 mm
■ Height: 1,300 mm

Dimensions

90 kg70 KgWeight

■ TIFF (uncompressed, Packbits, G3, G4 and LZW)
■ PDF, PDF/A (uncompressed, Flate and G4)
■ CALS
■ JPEG

Data format

sRGBColor space

■ Original type selection ‘Original types for the scanner’ on page
187

■ Color selection (Black&White / Gray / Color)
■ Brightness lighter/darker
■ Image optimization for fine details or speed

Image quality

■ Remove strips (leading/trailing/left/right)
■ Mirroring horizontal
■ Delete area

Image editing

■ Pre-programming of next job
■ Programmable default settings
■ Leading and trailing strip adjustment (0 mm - 400 mm)
■ Concurrent scanning
■ Scan to file Black&White / Gray.
■ Scan to file Color.

Other functions

FirewireInterface

85-264 VVoltage

47/63 HzFrequency

In operation: < 105 W
Standby: < 20 W

Power consump-
tion

TüV GS, CE, UL, (c)UL, CB, EMC Directive 89/336/EEC,
FCC

Safety approvals
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Specifications Océ Power Logic® controller

Océ Power Logic® controller hardware
#

Océ controller with Windows® XP embeddedPlatform

1024 MbMemory

250 Gb.Hard disk capacity

None, optional keyboard, mouse and monitorGraphical user interface

10/100BaseT with RJ45Standard interface

10/100BaseT with RJ45Optional interfaces

TCP/IP, SMB (for scan-to-file only), IPX/SPX,
FTP, LPD

Network protocols

Controller: < 100 WPower consumption

100-120 / 230 V, 50/60 HzElectrical requirements

Océ Power Logic® controller softwareApplicable software

Océ Power Logic® controller software
Scan module#

Océ Image LogicScan processing technology

■ Black and white
■ Grayscale (STF capability)
■ Color (STF capability)

Color modes
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Specifications Océ Scan Logic®

Scanner

Océ Scan Logic® offers you a flexible growth path with functionality designed to answer
your (future) needs for productivity, quality and advanced functionality.

#

Scan jobs workspace, part of the Océ TC4 Power Logic® con-
troller application, integrated scanning solution with Océ View
Station LT.

Application

Maximum of 10 destinations.
■ Scan to the local controller
■ Scan to a Microsoft® Windows network location with

Server Message Block (SMB)
■ Scan to an internet location with File Transfer Protocol

(FTP)

Scan destinations

72, 150, 200, 300, 400, and 600 dpi.Resolution

■ TIFF
■ Adobe certified PDF
■ CALS-I
■ JPEG

Supported PDLs

■ RAW
■ Striped
■ Tiled

Available file orga-
nization types for
TIFF files

■ Maximum (low compression, excellent quality)
■ High
■ Medium
■ Minimum (high compression, low quality)

Available compres-
sion for PDF file
type with JPEG
compression
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TIFF file format
■ None (uncompressed)
■ Group 3 2D
■ Group 4
■ Packbits
■ LZW.

PDF, PDF/A file format
■ JPEG compression
■ Group 4
■ Flate

CALS-I file format
■ Group 4.

Available file com-
pression methods

TIFF file format
■ Black & white, 1 bit per pixel
■ Grayscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

PDF, PDF/A file format
■ Black & white, 1 bit per pixel
■ Grayscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

CALS-I file format
■ Black & white, 1 bit per pixel.

Available color
depths

Single scanScan mode

Automatically generate unique file names for each scan.File naming

View scans at point of scanning.Viewing

The best scan quality for different image types.Océ Image Logic®

Green key principle
Scanner templates
Scan to file from the scanner operator panel.
Scan directly to a local or a remote destination.

Ease of use

Océ TC4 Power Logic® controller and Océ Power Logic®

controller Remote to have access to the system.
Requirements
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Océ View Station for editing and enhancement of scanned
documents
Océ Repro Desk
Océ Account Center
Océ Publisher Copy
Océ Batch Processor for automated editing

Options
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Original types for the scanner

Scanner

The original types that you can use for your color scanner are listed in the table below.

Original types#

IconTypeOriginal type

[74] Lines / text icon

'Lines&Text'Black & white /
gray

[75] Grays & lines icon

'Grays&Lines'

[76] Photo icon

'Photo'

[77] Transparent icon

'Transparent'

[78] Blueprint icon

'Blueprint'
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IconTypeOriginal type

[79] Dark original icon

'Dark original'

[80] Photo icon

'Photo'Color

[81] Artwork icon

'Artwork'

[82] Map icon

'Map'
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Reader's comment sheet

Questions

Have you found this manual to be accurate?
O Yes
O No

Were you able to operate the product, after reading this manual?
O Yes
O No

Does this manual provide sufficient background information?
O Yes
O No

Is the format of this manual convenient in size, readability and arrangement (page layout,
chapter order, etc.)?
O Yes
O No

Could you find the information you were looking for?
O Always
O Most of the times
O Sometimes
O Not at all

What did you use to find the required information?
O Table of contents
O Index

Are you satisfied with this manual?
O Yes
O No

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest improvements overleaf
or on a separate sheet.

Comments:
----------------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------------
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----------------------------------------------------------------------------------------------------------
----------------------
Date:

This reader's comment sheet is completed by:
(If you prefer to remain unknown, please do fill in your occupation)

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
For the attention of ITC User Documentation.
P.O. Box 101,
5900 MA Venlo
The Netherlands

Send your comments by E-mail to: itc-userdoc@oce.com

For the addresses of local Océ organisations see: http://www.oce.com
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Addresses of local Océ organisations

#

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Wienerbergstrasse 11
Vienna Twin Tower
1100 Vienna
Austria
http://www.oce.at/

Océ-Australia Ltd.
P.O. Box 363
Ferntree Gully MDC
Vic 3165
Australia
http://www.oce.com.au/

Océ-Brasil Comércio e Indústria Ltda.
Av. das Nações Unidas, 11.857
Brooklin Novo
São Paulo-SP 04578-000
Brasil
http://www.oce-brasil.com.br/

Océ-Belgium N.V./S.A.
J. Bordetlaan 32
1140 Brussel
Belgium
http://www.oce.be/

Océ Office Equipment (Shanghai)
First Shanghai Center, Phase II, Building
4,
Lane 180, Zhangheng Road
Pudong District
Shanghai 201204, P.R.
China
http://www.oce.com.cn/

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada
http://www.oce.ca/

Océ-Danmark a/s
Vallensbækvej 45
2605 Brøndby
Denmark
http://www.oce.dk/

Océ-Czech Republic ltd.
Babická 2329/2
149 00 Praha 4
Czech Republic
http://www.oce.cz/

Océ-France S.A.
32, Avenue du Pavé Neuf
93882 Noisy-le-grand, Cedex
France
http://www.oce.fr/

Océ Finland OY
Niittyrinne 7
02270 Espoo
Finland
http://www.oce.fi/
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Océ-Hong Kong and China head office
Room 3711-18 Tower 1
Millennium City 1
388 Kwun Tong Road
Kwun Tong
Kowloon
Hong Kong
http://www.oce.com.hk/

Océ-Deutschland GmbH
Solinger Straße 5-7
45481 Mülheim/Ruhr
Germany
http://www.oce.de/

Océ-Ireland Ltd.
3006 Lake Drive
Citywest Business Campus
Saggart
Co. Dublin
Ireland
http://www.oce.ie/

Océ-Hungaria Kft.
H-1241 Budapest
Pf.: 237
Hungary
http://www.oce.hu/

Océ Japan Corporation
1-28-1, Oi
Shinagawa-ku
Tokyo 140-0014
Japan
http://www.ocejapan.co.jp/

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia
http://www.oce.it/

Océ Malaysia Sdn. Bhd.
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Selangor Darul Ehsan
Malaysia
http://www.ocemal.com.my/

Océ-Belgium S.A.
Rue Astrid 2/A
1143 Luxembourg-Belair
http://www.oce.lu/

Océ-Norge A.S.
Postboks 4434 Nydalen
Gjerdrums vei 8
0403 Oslo
Norway
http://www.oce.no/

Océ-Mexico S.A. de C.V.
Prolongación Reforma 1236,
4to Piso
Col. Santa Fé, Del. Cuajimalpa
C.P. 05348
México, D.F.
México
http://www.oceusa.com/
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Océ-Portugal Equipamentos Gráficos S.A.
Av. José Gomes Ferreira, 11 Piso 2 - Mi-
raflores
1497-139 Algés
Portugal
http://www.oce.pt/

Océ-Poland Ltd. Sp.z o.o.
ul. Bitwy Warszawskiej 1920 r. nr. 7
02-366 Warszawa
Poland
http://www.oce.com.pl/

Océ Singapore Pte Ltd.
21 Ubi Road 1
#05-01 Brilliant Building
Singapore408724

Océ-Svenska AB
Sollentunavägen 84
191 27 Sollentuna
Sweden
http://www.oce.se/

Océ España SA
Business Park Mas Blau
Osona, 2 08820 El Prat de Llobregat
Barcelona
Spain
http://www.oce.es/

Océ (Thailand) Ltd.
B.B. Building 16/Floor
54 Asoke Road
Sukhumvit 21
Bangkok 10110
Thailand

Océ-Schweiz AG
Sägereistrasse 10
CH8152 Glattbrugg
Schweiz
http://www.oce.ch/

Océ (UK) Limited
Océ House
Chatham Way
Brentwood, Essex CM14 4DZ
United Kingdom
http://www.oce.co.uk/

Océ-Nederland B.V.
P.O.Box 800
5201 AV 's-Hertogenbosch
The Netherlands
http://www.oce.nl/

Océ North America Inc.
100 Oakview Drive
Trumbull, CT 06611
USA
http://www.oceusa.com/

Note:
The web site http://www.oce.com gives the current addresses of the local Océ organiza-
tions and distributors.
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Note:
The addresses of local Océ organizations for information about the Wide Format
Printing Systems and the Production Printing Systems can be different from the addresses
above. Refer to the web site http://www.oce.com for the addresses you need.
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Printing for
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Professionals everywhere look to Océ for digital printing

and document management. In the office, Océ systems

keep the information of business and government

flowing. In manufacturing, architecture, engineering,

and construction, Océ wide-format printers set the

standard, while our display graphics systems help people

produce banners, billboards, and other large, colorful

applications. In corporate print facilities, marketing

service bureaus, and the graphic arts industry, Océ

systems print transaction documents, mailings,

newspapers, manuals, and books—on demand and at

the highest speeds. And Océ Business Services manages

the complete document workflows of customers around

the world. It all helps you go “Beyond the Ordinary” in

printing and document management.

For more information visit us at:

www.oce.com
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